
 

 

 
 
 
 
 

Xmanager 4 User Guide 
Powerful PC X server for Windows 

 

 

NetSarang Computer, Inc. 





 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Copyright © 2011 NetSarang Computer, Inc. All rights reserved. 

Xmanager User Manual 

 

This product or document is protected by copyright and distributed under licenses restricting its use, copying, 
distribution, and decompilation. No part of this product or document may be reproduced in any form by any means 
without prior written authorization of NetSarang Computer, Inc. and its licensors, if any.  

This product or document can be changed for upgrading purpose without prior notice. 

Xmanager, and Xshell are registered trademarks of NetSarang Computer, Inc. Xlpd, and Xftp are trademarks of 
NetSarang Computer, Inc. Microsoft Windows is a trademark of Microsoft. Unix is a tradeamk of AT&T Bell 
Laboratories. SSH is a trademark of SSH Communications Security. Secure Shell is a trademark of SSH 
Communications Security. 

 

NetSarang Computer, Inc. 

Republic of Korea: 16F, Prime Center, 97, Technomart-gil, Gwangjin-gu, Seoul, 143-200  

United States of America: 3003 N. 1st Street, San Jose, CA, U.S.A., 95134 

http://www.netsarang.com/ 

http://www.netsarang.com/�




 

Table of Contents   |   i 

Table of Contents 
Xmanager Introduction ......................................................................................................................... 1 

Features ................................................................................................................... 1 
System requirements ................................................................................................. 2 
Installation and uninstallation ..................................................................................... 3 
Technical support ...................................................................................................... 3 
License Agreements................................................................................................... 3 

Xmanager License Agreement ............................................................................... 3 
Xmanager Evaluation License Agreement ............................................................... 4 

Getting Started ............................................................................................................................................. 7 
Starting with Xbrowser .............................................................................................. 7 
Starting with Xstart ................................................................................................. 11 

Managing Sessions .................................................................................................................................... 15 
Xstart session ......................................................................................................... 15 
Dynamic session ..................................................................................................... 16 
Static session .......................................................................................................... 17 
Configuring properties of a session ............................................................................ 18 
Creating a Folder ..................................................................................................... 19 
Export Sessions....................................................................................................... 19 
Import Sessions ...................................................................................................... 19 

Establishing Connections ....................................................................................................................... 21 
Connecting with Xbrowser ........................................................................................ 21 
Connecting with Xstart ............................................................................................. 21 
Configuring firewall .................................................................................................. 23 
Solving connection problems .................................................................................... 25 

Configuring Server Profiles ................................................................................................................... 27 
Managing Fonts .......................................................................................................................................... 29 
Configuring Keyboard and Mouse ....................................................................................................... 33 

Configuring keyboard ............................................................................................... 33 
Configuring mouse .................................................................................................. 34 

Managing Color ........................................................................................................................................... 37 
Using Window Mode ................................................................................................................................. 39 
Security .......................................................................................................................................................... 43 
Multiple Monitors ....................................................................................................................................... 47 
Copying, Saving and Printing X Applications ................................................................................. 49 
Logging Session .......................................................................................................................................... 51 
Reference ...................................................................................................................................................... 53 

Xmanager .............................................................................................................. 54 



 

ii   |   Table of Contents 

ii 
Xmanager system menu ..................................................................................... 56 
Xmanager tray menu .......................................................................................... 58 
Xmanager command line options ......................................................................... 59 

Xbrowser ................................................................................................................ 61 
Xbrowser main window ....................................................................................... 61 
File menu .......................................................................................................... 62 
Edit menu.......................................................................................................... 64 
View menu ........................................................................................................ 65 
Tools menu ........................................................................................................ 67 
Help menu ......................................................................................................... 68 
Session Context Menu ........................................................................................ 68 
Toolbar buttons .................................................................................................. 70 
Address bar ....................................................................................................... 71 
Options dialog box .............................................................................................. 72 
Xbrowser Properties dialog box ............................................................................ 75 
New Session Wizard ........................................................................................... 79 
Session Import Wizard ........................................................................................ 80 
Session Export Wizard ........................................................................................ 83 
Columns dialog box ............................................................................................ 86 
Secure XDMCP Setup dialog box .......................................................................... 88 

Xstart ..................................................................................................................... 91 
Xstart main window ............................................................................................ 92 
New Session dialog box ...................................................................................... 95 
SSH Protocol Setup dialog box ............................................................................. 95 
Forwarding Rule dialog box ................................................................................. 99 
Password Setup dialog box ................................................................................ 101 
Public Key Authentication Setup dialog box ......................................................... 101 
TELNET/RLOGIN/RSH/REXEC Protocol Setup dialog box ....................................... 102 
Registered Commands dialog box ...................................................................... 103 
Add Command dialog box ................................................................................. 104 
Xstart Advanced Options dialog box ................................................................... 105 
Command tag definition .................................................................................... 107 
Xrcmd command line options ............................................................................. 108 

Xconfig ................................................................................................................. 110 
Xconfig main window ........................................................................................ 110 
File menu ........................................................................................................ 111 
Edit menu........................................................................................................ 112 
View menu ...................................................................................................... 112 
Help menu ....................................................................................................... 113 
Toolbar buttons ................................................................................................ 114 
Properties dialog box ........................................................................................ 114 
Window Mode Settings dialog box ...................................................................... 125 



 

Table of Contents   |   iii 

Panning Settings dialog box .............................................................................. 128 
Add Font Server dialog box ............................................................................... 129 
Keyboard Settings dialog box ............................................................................ 130 
Add Keyboard dialog box .................................................................................. 132 
Mouse Settings dialog box ................................................................................ 132 
Sound Settings dialog box ................................................................................ 134 
Monitor Settings dialog box ............................................................................... 134 

Keyboard Editor .................................................................................................... 136 
Keyboard Editor main window ........................................................................... 136 
File menu ........................................................................................................ 137 
Edit menu ....................................................................................................... 138 
View menu ...................................................................................................... 138 
Help menu ...................................................................................................... 139 
Toolbar buttons ............................................................................................... 139 
Option bar ...................................................................................................... 140 
Normal layout ................................................................................................. 140 
Compose layout ............................................................................................... 142 
Select Keyboard Type dialog box ....................................................................... 143 
User-defined Keysym dialog box ........................................................................ 143 
Edit Key dialog box .......................................................................................... 144 
Edit Compose Sequence dialog box .................................................................... 146 

Common dialog box ............................................................................................... 148 
Host Keys dialog box ........................................................................................ 148 
User Keys dialog box ........................................................................................ 149 
User Key Properties dialog box .......................................................................... 150 
User Key Generation Wizard.............................................................................. 152 
SSH Security Warning dialog box ....................................................................... 157 
SSH User Authentication dialog box ................................................................... 158 

Fonts ................................................................................................................... 159 
Font format ..................................................................................................... 159 
Font name ...................................................................................................... 159 
Font directory .................................................................................................. 160 
Font server ..................................................................................................... 160 
Font catalogue and font path element ................................................................ 160 

Error Messages ..................................................................................................... 161 
Xmanager errors ............................................................................................. 161 
Xstart errors ................................................................................................... 161 
Xbrowser errors ............................................................................................... 162 

Index ......................................................................................................................................................... 163 
 

 





 

Xmanager Introduction   |   1 

Xmanager Introduction 
Xmanager is a powerful and easy-to-use PC X server software program that is running on a 
Windows platform. It allows you to bring remote UNIX/Linux desktops to your Windows PC 
seamlessly. You can also run remote X applications securely through the SSH (Secure Shell) 
protocol even when your Windows PC is inside a private nework and a firewall is between your 
PC and the remote server. 

Xmanager 3.0 incorporates a variety of new features such as multiple server profiles, multi-
visual, multi-monitor support, multi-user configuration, multiple XDMCP sessions and SSH 
security enhancement. It offers many advanced options to meet the needs of professional 
users and also has been designed as simply as possible for beginners. 

Features 
This section explains key features in Xmanager. 

Connection and Startup 

• Xbrowser program for managing multiple Xstart and XDMCP sessions 

• Xbrowser manages sessions for Xmanager, Xshell and Xftp 

• XDMCP, SSH, RSH, REXEC, RLOGIN and TELNET connection protocols 

• Up to 128 X client connections per Xmanager session 

• Shortcuts for Xstart and XDMCP sessions 

• Advanced prompt parsing and command scripting in Xstart 

• Secure XDMCP for XDMCP connection to the outside of firewall or private network  

Deployment 

• Support for Windows 2000 SP4 and above 

• Windows Terminal Server, Citrix XenServer for Windows 

• Session sharing for Windows terminal service 

• Silent Installation 

• Multi-user configuration 

• Easy distribution of sessions and server profiles 

• Supports user defined session path 

Security 

• Integrated SSH1/SSH2 protocols with public key authentication 

• SSH key generation wizard 

• SSH agent support through Xshell 

• Host-based Access control 

• XDMCP connection through SSH Security Tunneling 



 

2   |   Xmanager Introduction 

X Server 

• A high-performance X11R7 PC X server 

• Supports GLX 1.3 and OpenGL 1.2 (Xmanager Enterprise Edition only) 

• X Rendering extension protocol 

• Multiple server configuration 

• Multi-user support 

• Multiple monitor support 

• Support for multiple network adaptors 

• Multiple XDMCP sessions 

• Automatic display number allocation 

• Single & multiple window mode  

• Panning and Auto Raise support on local window manager 

• Multi-visual support 

• 256-color emulation in true-color video device 

• Automatic color substitution for PseudoColor visual 

• Backing Store support 

• Full Planemask feature for 256-color applications 

• Mouse wheel support  

• 3 button mouse emulation 

• Graphical keyboard editing 

• On the fly keyboard switching with a hot key 

• Sound file support for XBell request 

• Local Resource Database 

• Printing in multiple window mode 

• Automatic Cut & Paste between X and MS Windows applications 

• Tray icon 

Fonts 

• Font compiler 

• Font server support 

• BDF, PCF font format 

• Automatic font substitution  

• Additional font packages for each language and X application 

System requirements 
• Processor: Intel® compatible 

• Operating System: Microsoft Windows® 2000 SP4 or later 

• Hard disk: 100M bytes of free space 

• Network: TCP/IP Winsock 1.1 compatible or later 

• Required software: Internet Explorer® 6.0 or later 
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Installation and uninstallation 
The Xmanager installation program is available for download at http://www.netsarang.com/. 
It is packaged with the widely used InstallShield® installation program. To begin the 
installation process, simply run the executable file after downloading it. 

The Xmanager installation process includes several steps with options for you to modify the 
default installation. However, in most cases, just clicking Next button will be enough for the 
installation. 

To uninstall Xmanager, follow the standard Add/Remove feature of Windows. In the Control 
Panel, double-click Add/Remove Programs, click Xmanager in the program list, and then 
click Change/Remove button. 

IMPORTANT: The uninstallation process will not remove the registry information and data 
files generated by users. It can be used again when you need to re-install Xmanager later. If 
you want to remove all the files and registry information completely, you need to remove the 
following explicitly: 

 

Registry information: 

\HKEY_CURRENT_USER\Software\NetSarang\Xmanager 

\HKEY_CURRENT_USER\Software\NetSarang\Xmanager Enterprise 

 

File and folders: 

• %APPDATA%\NetSarang\Xmanager 

• %APPDATA%\NetSarang\Xmanager Enterprise 

Technical support 
The overall guide and reference information are in this Help manual in detail. If you cannot find 
a solution in this manual, please visit our web site at: 

 http://www.netsarang.com/support/main.html 

You can either post your questions on the Xmanager Q&A Forum or use our request support 
form on our online customer support page. Support request form is available at: 

http://www.netsarang.com/support/request_form.html 

We will be able to support you better if you describe your problem as detailed as possible. 

License Agreements 

Xmanager License Agreement 
This license agreement applies to the registered version of Xmanager. If you are using 
Xmanager for evaluation, see “Xmanager Evaluation License Agreement”. 

License Agreement 

Carefully read the following terms and conditions before using this software. Your use of this 

http://www.netsarang.com/�
http://www.netsarang.com/support/main.html�
http://www.netsarang.com/support/request_form.html�
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software indicates your acceptance of this license agreement. No component part of any 
version of Xmanager may be distributed individually, disassembled, copied, reverse 
engineered, or altered in any form. 

Registered Version 

One registered copy of Xmanager may either be used by a single person who uses the 
software personally on one or more computers, or installed on a single workstation used non-
simultaneously by multiple people, but not both. 

You may access the registered version of Xmanager through a network, provided that you 
have obtained individual licenses for the software covering all workstations that access the 
software through the network. For instance, if five different workstations will access 
Xmanager on the network, each workstation must have its own Xmanager license, 
regardless of whether they use Xmanager at different times or concurrently. 

Title and Copyright 

The software (including any images, applets, photographs, animations, video, audio, music and 
text incorporated into the software) is owned by NetSarang Computer, Inc., or its suppliers and 
is protected by Korean copyright laws and international treaty provisions. Part of this software 
may have been developed by a third party software supplier, which holds copyright and other 
proprietary rights to the software. 

This software is licensed to you. You are not obtaining title to the software or any copyrights. 
You may not sublicense, rent, or lease the software for any purpose. The license may be 
transferred (not resold) to another individual only if you keep no copies of the software. 

Disclaimer of Warranty 

THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT 
WARRANTIES AS TO PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES 
WHETHER EXPRESSED OR IMPLIED. Because of the various hardware and software 
environments into which Xmanager may be put, NO WARRANTY OF FITNESS FOR A 
PARTICULAR PURPOSE IS OFFERED. 

Xmanager® is a registered trademark of NetSarang Computer, Inc. 

Xmanager Evaluation License Agreement 
This license agreement applies to the evaluation version of Xmanager. If you are a registered 
user, see “Xmanager License Agreement”. 

License Agreement 

Read carefully the following terms and conditions before using this software. Your use of this 
software indicates your acceptance of this license agreement and warranty. 

Evaluation and Registration 

Xmanager is not a free software program. Subject to the terms below, you are hereby 
licensed to use the Evaluation Version of Xmanager for evaluation purposes without charge for 
a period of 30 days. Any other use requires purchase of a license for the registered version, as 
described in Ordering Information. Unregistered use of Xmanager after the 30-day evaluation 
period is in violation of Korean and international copyright laws. 
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Distribution of Evaluation Version 

You are hereby licensed to make as many copies of the evaluation version of this software and 
documentation as you wish; give exact copies of the original evaluation version to anyone; and 
distribute the evaluation version of the software and documentation in its unmodified form via 
electronic means. There is no charge for any of the above. 

You are specifically prohibited from charging, or requesting donations, for any such copies, 
however made; and from distributing the software and/or documentation with other products 
(commercial or otherwise) without prior written permission from NetSarang Computer, Inc., 
with no exceptions. 

Disclaimer of Warranty 

THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT 
WARRANTIES AS TO PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES 
WHETHER EXPRESSED OR IMPLIED. Because of the various hardware and software 
environments into which Xmanager may be put, NO WARRANTY OF FITNESS FOR A 
PARTICULAR PURPOSE IS OFFERED. 

Xmanager® is a registered trademark of NetSarang Computer, Inc. 
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Getting Started 
This section explains how to connect to a remote UNIX/Linux host and how to bring a remote X 
application or full remote desktop to your Windows desktop. 

Xmanager provides two basic methods to access remote UNIX/Linux hosts: Xbrowser and 
Xstart. With Xbrowser, you can bring a full remote desktop to your Windows desktop through 
XDMCP (X Display Manager Control Protocol) and it is much easier for most users. With Xstart, 
you can get a single remote X application such as xterm and it is faster and simpler than 
XDMCP connection. 

Once you have installed Xmanager successfully, you will be able to find Xstart and Xbrowser 
programs in the Xmanager folder on the desktop. 

Starting with Xbrowser 
Xbrowser helps you to find UNIX/Linux hosts on your network and connect to a host using 
XDMCP protocol. 

To use Xbrowser, the remote Unix host should be configured to allow XDMCP service for 
remote X terminals. Usually one of dtlogin, kdm, gdm or xdm should be running on the host. 
For more information about configuring XDMCP service on the Unix host, please refer to the 
manual of your Unix server. 

1. Open the Xmanager folder on your desktop. 
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Figure 1: Xmanager Folder 

2. Double-click Xbrowser. 

RESULT: The Xbrowser window opens, as the figure below shows. 

 Notes 

Xbrowser finds all UNIX/Linux hosts on your local network automatically. If UNIX/Linux 
host that you wish to access is in different network with the one of user’s PC, open Options 
dialog box and register IP address or Broadcast address of the host, then try it again. If 
your UNIX host is not listed on the Xbrowser window, the host is not ready to serve XDMCP 
connections. 
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Figure 2: Xbrowser Main Window 

3. Double-click the host you want to connect to. 

RESULT: A graphic login window opens, as the figure below shows. 

 Notes 

If you are not able to get a graphic login window, there may be a firewall between your PC 
and the remote host. 
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Figure 3: XDMCP Login Window 

4. To log on to the host, enter your account name and password. 

RESULT: A remote desktop opens, as the figure below shows. 

 Notes 

If the remote desktop does not open after entering username and password, there may be 
an error in your login shell scripts. 



 

Getting Started   |   11 

 

Figure 4: UNIX Desktop on Windows 

If you experience any problem in using Xbrowser, visit our support page at: 

 http://www.netsarang.com/support/main.html 

From the support page, you can find some tips about configuring UNIX/Linux servers for 
XDMCP connections. 

Starting with Xstart 
Xstart helps you to run a remote X application. Once you have created an Xstart session, you 
can bring a remote X application on your Windows with a single click. 

1. From the Xmanager folder, run Xstart. 

RESULT: The Xstart window opens, as shown in the figure below. 

http://www.netsarang.com/support/main.html�
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Figure 5: Xstart Main Window 

2. Click New. 

RESULT: A New Session dialog box appears, as you see below. 

 

Figure 6: Xstart New Session Dialog Box 

3. Enter a new session name, and click OK. 

4. In the Host box, enter the hostname or IP address of the remote UNIX/Linux host. 

5. In the Protocol box, select an appropriate protocol that is available on the host. 

6. To set up protocol-specific options such as port and time-out, click Setup. 

7. In the Username box, enter the user account on the host. 

8. If you want to save the Password to the session, click the Setup button next to the 
Password field.  
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RESULT: Password Setup dialog box opens. 

 

Figure 7: Password Setup Dialog Box  

9. In the Execution Command box, enter a command that will be executed on the host. For 
example, enter the following to run an xterm: 
/usr/bin/X11/xterm –ls –display $DISPLAY 

10. Click Run. 

RESULT: An xterm window opens, as shown in the figure below. 

 

Figure 8: Xterm Window 
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If you experience any problem in using Xstart, visit our support page at: 

 http://www.netsarang.com/support/support.html 

Most problems are caused by a firewall configuration on your systems and network. So, you 
may need to consult your system administrator to solve the problems. 

http://www.netsarang.com/support/support.html�
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Managing Sessions 
A session contains properties of a connection to a remote host. By creating a session, you can 
specify different options and a server profile for each connection. 

This section explains Xstart and Xbrowser sessions, creating a shortcut for a session and 
configuring a server profile for a session. For more information about Xstart and Xbrowser, 
refer to “Xstart” and “Xbrowser”. 

You can save the sessions in a folders and open all sessions in the folder simultaneously.  

Xstart session 
By creating an Xstart session, you can open remote X applications from PC. Xstart session 
automatically processes the login steps and runs the specified X application. 

You can create Xstart sessions with both Xstart and Xbrowser. 

To create a session on Xstart: 

1. From the Xmanager folder, run Xstart. 

RESULT: The Xstart window opens. 

2. Click New. 
RESULT: A New Session dialog box appears. 

3. Enter a new session name, and click OK. 

4. In the Host box, enter the hostname or IP address of the remote UNIX/Linux host. 

5. In the Protocol box, select an appropriate protocol that is available on the host. The 
TELNET protocol is appropriate for most hosts. 

6. To set up protocol-specific options such as port and time-out, click Setup. 

7. In the Username box, enter the user account on the host. 

8. If you want to save the Password to the session, click the Setup button next to the 
Password field.  

RESULT: Password Setup dialog box opens. 

9. In the Execution Command box, enter a command that will be executed on the host. For 
example, enter the following to run an xterm: 
/usr/bin/X11/xterm –ls –display $DISPLAY 

10. Click Save. 

To create a session with Xbrowser: 

1. From the Xmanager folder, run Xbrowser. 
RESULT: The Xbrowser window opens. 

2. In the File menu, point to New, and then click Xstart Session. 
RESULT: A new Xstart session is created on the Xbrowser window. 

3. Right-click on the new Xstart session. 
RESULT: A menu appears. 

4. Click Properties. 
RESULT: A Properties dialog box opens. 
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5. Click the General tab. 

6. In the Host box, enter the hostname or IP address of the remote UNIX/Linux host. 

7. In the Protocol box, select an appropriate protocol that is available on the host. The 
TELNET protocol is appropriate for most hosts. 

8. To set up protocol-specific options such as port and time-out, click Setup. 

9. In the Username box, enter the user account on the host. 

10. In the Password box, enter the password of the user account. 

11. In the Execution Command box, enter a command that will be executed on the host. For 
example, enter the following to run an xterm: 
/usr/bin/X11/xterm –ls –display $DISPLAY 

12. Click OK. 

 Notes 

You can also create an Xstart session with New Session Wizard provided by Xbrowser. To 
use it, point to New in the File menu, and then click New Session Wizard. 

To create a shortcut for an Xstart session: 

1. Run Xstart. 

2. In the Session list, select a session. 

3. Click Shortcut. 
RESULT: A Browse for Folder dialog box appears. 

4. Select a folder in which you want to put a shortcut of the session. 

Dynamic session 
Xbrowser sends an XDMCP broadcast message to all hosts in your local network and shows 
the hosts which respond to the message as available sessions. Any hosts that responds to the 
messages shows up on the top level XDMCP folder. 

Also, Xbrowser provides an option to find a host in a different network. You can disable the 
broadcast feature when there are too many hosts in your local network. 

To find hosts in a different network: 

1. Run Xbrowser. 

2. In the Tools menu, click Options. 

RESULT: An Options dialog box opens. 

3. In the New Address box, enter the hostname you want to find. 

4. Click Add. 

5. Click OK. 

To disable local broadcast: 

1. Run Xbrowser. 

In the Tools menu, click Options. 
RESULT: An Options dialog box opens. 

2. Clear the Use local broadcast address check box. 

3. Click OK. 
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Static session 
Static sessions are user created sessions. On Xbrowser, you can create Passive, XDMCP Query, 
XDMCP Broadcast, XDMCP indirect, and Secure XDMCP sessions. Unlike the Dynamic sessions 
which are available only when the remote hosts respond to the XDMCP braodcast message, the 
Static sessions are always shown on Xbrowser. 

To create a Passive session: 

1. Run Xbrowser. 

2. In the File menu, point to New, and then click New Session Wizard. 

RESULT: A New Session Wizard opens. 

3. Select Passive and then click Next. 

4. In the X Server Profile list box, select an appropriate server profile and then click Next. 

5. In the Name box, enter a session name. 

6. Click Finish. 

To create an XDMCP Query/Broadcast/Indirect/Secure XDMCP session: 

1. Run Xbrowser. 

2. In the File menu, point to New, and then click New Session Wizard. 

RESULT: A New Session Wizard  opens. 

3. Select XDMCP and then click Next. 

4. In the Connection Method list box, select Query, Broadcast, Indirect, or Secure 
XDMCP. 

5. In the Host box, enter the hostname of the remote host and then click Next. 

6. In the X Server Profile list box, select an appropriate server profile and then click Next. 

7. In the Name box, enter a session name. 

8. Click Finish. 

To create a shortcut for a static session: 

1. Run Xbrowser. 

2. Right-click on a session. 

RESULT: A menu appears. 

3. Click Shortcut. 

To send a session to another user via email: 

1. Run Xbrowser. 

2. Right-click on a session. 

RESULT: A menu appears. 

3. Point to Send To and then click Mail Recipient. 

To import a session: 

1. Drag a session with a left-click. 

2. Drop on the Xbrowser window. 
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 Notes 

You can only import static sessions saved as a file. Dynamic sessions cannot be imported. 

To share a session with other users: 

1. Run Xbrowser. 

2. Right-click on a session. 
RESULT: A menu appears. 

3. Click Sharing. 

 Notes 

A shared session is moved to a common folder and you should have an administrative 
privilege to do the task. 

To save Dynamic sessions as Static sessions: 

1. Run Xbrowser. 

2. Select the Dynamic sessions and right-click on a session. 
RESULT: A menu appears. 

3. Click Save as.  

Configuring properties of a session 
A session contains basic connection information such as hostname and port. You also have the 
option to specify a display number and a server profile for Xmanager it invokes. 

To allocate a static display number for a session: 

1. Run Xbrowser. 

2. Right-click on a session. 

RESULT: A menu appears. 

3. Click Properties. 

RESULT: A Xbrowser Properties dialog box opens. 

4. Click the X Server tab. 

5. Clear the Allocate display number automatically check box. 

6. In the Display Number box, enter an appropriate display number. 

7. Click OK. 

To associate a session with a server profile: 

1. Run Xbrowser. 

2. Right-click on a session. 

RESULT: A menu appears. 

3. Click Properties. 

RESULT: A Xbrowser Properties dialog box opens. 

4. Click the  X Server tab. 

5. In the Server Profile list, select an appropriate profile. 

6. Click OK. 
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Creating a Folder 
Xmanager supports folder. You can save the sessions in folder. To create a new folder: 

1. Run Xbrowser. 

2. Click on the File menu, point to New and then select the Folder menu. 

RESULT: A new folder is created. 

3. Enter the name for the folder. 

Export Sessions 
Xmanager supports exporting sessions. Sessions are exported to single file for easy import. 
You can import the exported session file from a different PC where Xmanager is installed and 
use it without extra configuration. To export sessions: 

4. Run Xbrowser. 

5. Click on the File menu, select the Export menu. 

RESULT: The Import/Export wizard dialog box opens. 

6. Select the products to export its sessions, and then click the Next button. 

7. Select the folder where the exported session file will be saved and then click the Next 
button. 

RESULT: Sessions are exported to a single file. 

8. Click the OK button to close the Import wizard. 

Import Sessions 
Xmanager supports importing sessions. You can import sessions from the lower Xmanager 
versions from the same PC or the exported session file that is exported from a different PC. To 
import sessions: 

1. Run Xbrowser. 

2. Click on the File menu, select the Import menu. 

RESULT: The Import/Export wizard dialog box opens. 

 

• To import sessions from the previously installed products on the same PC: 

3. Select the From the previously installed products on this computer option, and the 
click the Next button. 

RESULT: Products and its sessions are listed. 

4. Select the products to import sessions from and then click the Next button. 

RESULT: Sessions are imported and the result is displayed. 

5. Click the OK button to close the Export wizard. 

 

• To import sessions from the an exported session file: 

3. Select the From the following location option. 

4. Enter the path of the exported session file or click the … button to select the exported 
session file.  

5. Click the Next button to continue. 
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RESULT: Products and its sessions are listed. 

6. Select the name of the products to import sessions from, and then click the Next button. 

RESULT: Sessions are imported and the result is displayed. 

7. Click the OK button to close the Export wizard. 
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Establishing Connections 
Xmanager provides two convenient tools to connect to a remote host: Xbrowser and Xtart. 
Xbrowser is a comprehenisve session management tool that you can use to manage not only 
Xmanager sessions but also Xshell and Xftp sessions. And, Xstart is useful when you want 
to run a single X application quickly and do not need the full desktop access such as Gnome 
and KDE.  

This section explains a variety of connection methods and examples to manage with complex 
network environment and solve connection problems. 

Connecting with Xbrowser 
Xbrowser broadcasts an XDMCP query message to all the hosts in your local network and 
finds the hosts that respond to the query message automatically.  

To connect to a host with XDMCP: 

1. Run Xbrowser. 

2. Double-click the host you want to connect to. 

RESULT: Xmanager brings up and connects to the host with XDMCP protocol. 

To connect to a host using the Address Bar: 

1. Run Xbrowser. 

2. In the Address bar, enter the hostname or the IP address of the remote host. 

3. Press Enter key. 

Connecting with Xstart 
Using Xstart, you can quickly start the remote X applications on PC. Xstart supports SSH, 
TELNET, RLOGIN, REXEC, RSH and LOCAL connection protocols. Each connection protocol 
requires a corresponding server is running on the remote host. For example, SSH server is 
required on the remote host to use SSH protocol.  

Use the LOCAL protocol when you run a local X application that is installed on your Windows. 
For more information about using Xstart, see “Xstart”. 

To run a remote X application with SSH protocol: 

1. Run Xstart. 

2. Click New. 

RESULT: A New Session dialog box appears. 

3. Enter a new session name, and click OK. 

4. In the Host box, enter the hostname or IP address of the remote UNIX/Linux host. 

5. In the Protocol box, select SSH. 

6. To set up SSH protocol-specific options such as public key authentication, click Setup. 

7. In the Username box, enter the user account on the host. 
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8. In the Execution Command box, enter a command that will be executed on the host. For 
example, enter the following to run an xterm: 
/usr/bin/X11/xterm –ls –display $DISPLAY 

9. Click Run. 

To run a remote X application with TELNET protocol: 

1. Run Xstart. 

2. Click New. 

RESULT: A New Session dialog box appears. 

3. Enter a new session name, and click OK. 

4. In the Host box, enter the hostname or IP address of the remote UNIX/Linux host. 

5. In the Protocol box, select TELNET. 

6. To set up TELNET protocol-specific options such as port and time-out, click Setup. 

7. In the Username box, enter the user account on the host. 

8. If you want to save the Password to the session, click the Setup button next to the 
Password field.  

RESULT: Password Setup dialog box opens. 

9. In the Execution Command box, enter a command that will be executed on the host. For 
example, enter the following to run an xterm: 
/usr/bin/X11/xterm –ls –display $DISPLAY 

10. Click Run. 

To run a remote X application with RLOGIN protocol: 

1. Run Xstart. 

2. Click New. 

RESULT: A New Session dialog box appears. 

3. Enter a new session name, and click OK. 

4. In the Host box, enter the hostname or IP address of the remote UNIX/Linux host. 

5. In the Protocol box, select RLOGIN. 

6. To set up RLOGIN protocol-specific options such as port and time-out, click Setup. 

7. In the Username box, enter the user account on the host. 

8. If you want to save the Password to the session, click the Setup button next to the 
Password field.  

RESULT: Password Setup dialog box opens. 

9. In the Execution Command box, enter a command that will be executed on the host. For 
example, enter the following to run an xterm: 
/usr/bin/X11/xterm –ls –display $DISPLAY 

10. Click Run. 

To run a remote X application with REXEC protocol: 

1. Run Xstart. 

2. Click New. 

RESULT: A New Session dialog box appears. 

3. Enter a new session name, and click OK. 
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4. In the Host box, enter the hostname or IP address of the remote UNIX/Linux host. 

5. In the Protocol box, select REXEC. 

6. To set up REXEC protocol-specific options such as port and time-out, click Setup. 

7. In the Username box, enter the user account on the host. 

8. If you want to save the Password to the session, click the Setup button next to the 
Password field.  

RESULT: Password Setup dialog box opens. 

9. In the Execution Command box, enter a command that will be executed on the host. For 
example, enter the following to run an xterm: 
/usr/bin/X11/xterm –ls –display $DISPLAY 

10. Click Run. 

To run a remote X application with RSH protocol: 

1. Run Xstart. 

2. Click New. 

RESULT: A New Session dialog box appears. 

3. Enter a new session name, and click OK. 

4. In the Host box, enter the hostname or IP address of the remote UNIX/Linux host. 

5. In the Protocol box, select RSH. 

6. To set up RSH protocol-specific options such as port and time-out, click Setup. 

7. In the Username box, enter the user account on the host. 

8. In the Execution Command box, enter a command that will be executed on the host. For 
example, enter the following to run an xterm: 
/usr/bin/X11/xterm –ls –display $DISPLAY 

9. Click Run. 

To run a local X application with Xstart: 

1. Run Xstart. 

2. Click New. 

RESULT: A New Session dialog box appears. 

3. Enter a new session name, and click OK. 

4. In the Protocol box, select LOCAL. 

5. In the Execution Command box, enter the full path of the local application. For example, 
enter the following to run an xlogo: 
C:\Program Files\Xapps\xlogo –display $DISPLAY 

6. Click Run. 

Configuring firewall 
You may need to alter the network settings when the remote hosts are on a different network 
over a gateway or when a firewall is between the PC and the remote host. Please keep in mind 
that Xmanager is a server (PC X server), and the connection is established from the remote X 
application to the Xmanager.  

Port-forwarding is required for XDMCP connections when you are in a private network and you 
connect to a remote host over a router. Once you have configured port-forwarding on the 
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router, you should configure connection address for XDMCP connections. 

If the firewall is forced to disconnect the idle connections, enable the Send keep-alive signal 
option for SSH sessions.  

To enable the Send keep-alive signal option for SSH connections: 

1. Run Xstart. 

2. In the Session list, select a session. 

3. In the Protocol list, select SSH. 

4. Click Setup. 

RESULT: An SSH Protocol Setup dialog box opens. 

5. Click the General tab. 

6. Select the Send keep-alive signal check box. 

7. Click OK. 

To configure port-forwarding rules on a router: 

1. Connect to the router and go to the port-forwarding page. 

2. Forward external TCP ports 6000 ~ 6010 to the ports 6000 ~ 6010 of your Windows. For 
example, assumes that the IP address of your PC is 192.168.1.2: 
External Port Port Address 
6000  6000 192.168.1.2 
6001  6001 192.168.1.2 
… 
6010  6010 192.168.1.2 

3. Save the configuration. 

 Notes 

Refer to the manual of your router to configure the port forwarding. 

To configure a connection address for XDMCP sessions: 

1. Run Xbrowser. 

2. Right-click on the session you want to configure a connection address setting. 

RESULT: A menu appears. 

3. Click Properties. 

RESULT: A Xbrowser Properties dialog box opens. 

4. Click the General tab. 

5. In the Connection Address area, select Use following connection address check box. 

6. In the Host box of the Connection Address area, enter the IP address of the router. 

7. In the Port Number box of the Connection Address area, enter “6001”. 

 Notes 

This number is a router side port number which is configured to perform port-forwarding 
from router to PC. 

8. Click the X Server tab. 
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9. In the Display Number area, clear the Allocate display number automatically check 
box. 

10. In the Display Number box, enter “1”. 

 Notes 

This number comes from the port number “6001” which is configured to perform port-
forwarding from router to PC. If you subtract 6000 from the port number, the result will be 
the display number. 

11. Click OK. 

Solving connection problems 
If you failed to establish connection to the remote host after following the previous 
instructions, these are some questions and information that can help you solve the problem. 

To solve XDMCP connection problems: 

1. Check the following: 

• Is a dtlogin, kdm, gdm or xdm running on the remote host? 

• Does the login window open? 

• Is the remote host on a different network? 

• Is there a firewall between your Windows and the remote host? 

• Does your Windows system have a firewall configuration? 

• The name server may have an incorrect entry for your PC. 

• The DISPLAY variable is configured incorrectly on your shell script. 

2. See log messages. 

• To see Xmanager log files, click the system menu on Xmanager main window, point 
to Log, and then click File. 

• For CDE errors, read /var/dt/Xerrors when you cannot see the login window. Read 
$HOME/.dt/startlog and $HOME/.dt/errorlog when you failed to login. 

To solve Xstart connection problems: 

1. Run Xstart. 

2. Select Show status dialog box. 

3. Select Show reply messages. 

4. Click Run. 

RESULT: A Reply Messages dialog box opens. 

5. Read the reply messages to find the reason of the problem. 
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Configuring Server Profiles 
Xconfig is a tool that lets you manage server profiles. A server profile contains X Server 
related options such as window mode, fonts, color, and security. You can make multiple profiles 
on Xconfig and assign a differerent profile for each session.  

When you create a session, Default Profile is assigned to the session. Two default profiles are 
created for you automactially when you install Xmanager. 

To create a new server profile: 

1. Run Xconfig. 

2. In the File menu, click New Profile. 

RESULT: A New Profile is created on the Xconfig window. 

3. Double-click on the new profile. 

RESULT: A Properties dialog box opens. 

4. Configure options on the dialog box. 

5. Click OK. 

To set a profile as the default Xstart profile: 

1. Run Xconfig. 

2. Right-click on the profile that will be set as a default Xstart profile. 

RESULT: A menu appears. 

3. Click Set as Default Xstart Profile. 

To set a profile as the default XDMCP profile: 

1. Run Xconfig. 

2. Right-click on the profile that will be set as a default XDMCP profile. 

RESULT: A menu appears. 

3. Click Set as Default XDMCP Profile. 

To share a profile with other users on Windows: 

1. Run Xconfig. 

2. Right-click on the profile that will be shared with other users on the local machine. 

3. Click Sharing. 

To email a profile: 

1. Run Xconfig. 

2. Right-click on a profile. 

RESULT: A menu appears. 

3. Point to Send To and then click Mail Recipient. 

RESULT: A mail composer opens with the profile attached. 
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To export a profile to a folder: 

1. Run Xconfig. 

2. Drag a profile and drop it on a folder. 

To import a profile: 

1. Run Xconfig. 

2. Drag a profile and drop it on Xconfig. 
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Managing Fonts 
Xmanager provides many fonts for X applications. When installing Xmanager, you can select 
font packs to install depending on the vendor of Unix server and your language. 

Even though Xmanager includes many fonts required for most systems and applications, you 
can still add new fonts. Thus, this section explains how to: install additional fonts, add a font 
server and configure font options. 

For more information about fonts, see “Fonts”. 

To install additional font packs: 

1. Visit Xmanager download page at: 
http://www.netsarang.com/download/download.html 

2. Download additional font packs you want to install. 

3. Run it on your Windows. 

4. Follow the guidance of the installation wizard. 

 Notes 

The font pack applies the new font directory to all server profiles. So, you do not have to 
add the new font directory using Xconfig. 

To convert BDF fonts to PCF fonts: 

1. Run bdftopcf.exe as following: 
C:\tmp> %XMANAGER_INSTALL_DIR%\bdftopcf new.bdf –o new.pcf 

To create or update FONTS.DIR using mkfntdir.exe: 

1. Go to the font directory and run mkfntdir.exe: 
%XMANAGER_INSTALL_DIR%\Fonts\NewFonts> ..\..\mkfntdir 

To create and use a font directory: 

1. Create a new directory under the following directory: 
C:\Program Files\NetSarang\Xmanager2\Fonts 

2. Copy new fonts to the new directory. 

3. Run mkfntdir.exe on the new directory: 
C:\Program Files\…\Fonts\NewFonts> ..\..\mkfntdir . 

4. Run Xconfig. 

5. Double-click on the profile you want to change the font catalogue. 

RESULT: A Properties dialog box opens. 

6. Click the Font tab. 

7. Click Add Font Directory. 

RESULT: A Browse for Folder dialog box opens. 

8. Select the new font directory created above. 

9. Click OK. 

http://www.netsarang.com/download/download.html�
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10. Restart Xmanager. 

To use a font server: 

1. Run Xconfig. 

2. Double-click on the profile. 

RESULT: A Properties dialog box opens. 

3. Click the Font tab. 

4. Click Add Font Server. 

RESULT: An Add Font Server dialog box opens. 

5. In the Hostname box, enter the IP address or hostname of the font server. 

6. In the Port box, enter the port number of the font server. 

7. Click OK. 

 Notes 

Make sure that a font server is running on the remote host. Usually the program name is 
xfs and the default port is 7100. 

To change the default text font: 

1. Run Xconfig. 

2. Double-click on the profile. 

RESULT: A Properties dialog box opens. 

3. Click the Font tab. 

4. In the Default Font box, enter a font name that will be used as a default text font. 

5. Click OK. 

 Notes 

A default text font is used when an X application does not specify a font name to display 
characters. 

To use font aliasing when a desired font is not found: 

1. Run Xconfig. 

2. Double-click on the profile. 

RESULT: A Properties dialog box opens. 

3. Click the Font tab. 

4. Select the Automatic Font Substitution check box. 

5. Click OK. 

To show missing font dialog box: 

1. Run Xconfig. 

2. Double-click on the profile. 

RESULT: A Properties dialog box opens. 

3. Click the Font tab. 

4. Select the Show Missing Font Dialog check box. 
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5. Click OK. 
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Configuring Keyboard and 
Mouse 
Xbrowser includes Keyboard Editor that allows you to define the custom keyboard layouts for 
international keyboards that are different from the standard AT keyboard. It also supports 
various mouse options for scrolling and swapping buttons. 

Configuring keyboard 
You can select a keymap file, specify a hot key to switch keymaps on the fly and edit a keymap 
file with Keyboard Editor.  

To add more Keymap files to the keyboard list: 

1. Run Xconfig. 

2. Double-click on a profile. 

RESULT: A Properties dialog box opens. 

3. Click the Devices tab. 

4. Click Keyboard Settings. 

RESULT: A Keyboard Settings dialog box opens. 

5. Click Add. 

RESULT: An Add Keyboard dialog box opens. 

6. Select an appropriate keymap file. 

7. Click OK. 

To set a keymap as a default keymap: 

1. Run Xconfig. 

2. Double-click on a profile. 

RESULT: A Properties dialog box opens. 

3. Click the Devices tab. 

4. Click Keyboard Settings. 

RESULT: A Keyboard Settings dialog box opens. 

5. In Keyboard List, select a keymap that will be used by default. 

6. Click Set Default. 

7. Click OK. 

To switch keymaps on the fly: 

1. While Xmanager is running, press Ctrl+Alt+K. 

RESULT: A Keyboard Selector dialog box opens. 

2. While keeping the Ctrl+Alt keys pressed, press and release the K key to select a keymap. 
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3. Release all keys. 

 Notes 

In the Keyboard Selector dialog box, you can see only the keymaps those are in the 
Keyboard List of the Keyboard Settings dialog box. 

To edit a keymap file: 

1. Run Xconfig. 

2. Double-click on a profile. 

RESULT: A Properties dialog box opens. 

3. Click the Devices tab. 

4. Click Keyboard Settings. 

RESULT: A Keyboard Settings dialog box opens. 

5. In Keyboard List, select a keymap. 

6. Click Edit. RESULT: A Keyboard Editor opens. 

Configuring mouse 
Xmanager allows you to configure 3-button emulation, enable or disable mouse wheel support 
for easier scrolling, and switch middle/right buttons. 

To emulate 3-button with a 2-button mouse: 

1. Run Xconfig. 

2. Double-click on a profile. 

RESULT: A Properties dialog box opens. 

3. Click the Devices tab. 

4. Click Mouse Settings. 

RESULT: A Mouse Settings dialog box opens. 

5. Select the Click the left and right buttons simultaneously check box. 

6. Click OK. 

To scroll using the wheel in X applications: 

1. Run Xconfig. 

2. Double-click on a profile. 

RESULT: A Properties dialog box opens. 

3. Click the Devices tab. 

4. Click Mouse Settings. 

RESULT: A Mouse Settings dialog box opens. 

5. Select the Use Mouse Wheel check box. 

6. Click OK. 

 Notes 

When the wheel is used for scrolling, the right-click may not work in some X applications 
such as the CDE desktop menu. 
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To switch a right-click to a middle-click: 

1. Run Xconfig. 

2. Double-click on a profile. 

RESULT: A Properties dialog box opens. 

3. Click the Devices tab. 

4. Click Mouse Settings. 

RESULT: A Mouse Settings dialog box opens. 

5. Select the Use Right Button as Middle Button check box. 

6. Click OK. 





 

Managing Color   |   37 

Managing Color 
Xmanager supports 6 visual types simultaneously. If your video devie supports more than 16-
bit colors, Xmanager sets the default visual as TrueColor. Otherwise, PseudoColor is used. The 
default visual is used by the X root window and most X applications. 

However, some X applications such as old CAD tools are developed specifically for 256-color 
systems. These applications work only on PseudoColor visual, and you must set the visual to 
PseudoColor. 

Xmanager can emulate PseudoColor visual on a true-color video device. When Xmanager 
emulates PseudoColor visual, the StoreColor request is a very expensive operation that slows 
down the performance. Therefore, Xmanager supports the full StoreColor feature optionally. 

Some X applications are designed to run on specific UNIX/Linux RGB formats and may fail to 
run on TrueColor visual. To resolve this problem, Xmanager provides an option to set the the 
RGB format on TrueColor.  

Also, Xmanager supports an RGB database file which translates color names to corresponding 
RGB values. You can edit the color database using a text editor. 

To change the default server visual: 

1. Run Xconfig. 

2. Double-click on a profile. 

RESULT: A Properties dialog box opens. 

3. Click the Color tab. 

4. In the Choose Default Visual list, select an appropriate visual. 

5. Click OK. 

To process the exact StoreColor requests in PseudoColor visual: 

1. Run Xconfig. 

2. Double-click on a profile. 

RESULT: A Properties dialog box opens. 

3. Click the Color tab. 

4. Select the Exact StoreColor for PseudoColor check box. 

5. Click OK. 

To emulate 256-color visual in true-color video device: 

1. Run Xconfig. 

2. Double-click on a profile. 

RESULT: A Properties dialog box opens. 

3. Click the Color tab. 

4. In the Choose Default Visual list, select PseudoColor. 

5. Click the Advanced tab. 

6. Select When Mapped for the Backing Store option. 

7. Click OK. 
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To reverse the order of RGB fields in TrueColor visual: 

1. Run Xconfig. 

2. Double-click on a profile. 

RESULT: A Properties dialog box opens. 

3. Click the Color tab. 

4. Select the Reverse RGB Order for TrueColor check box. 

5. Click OK. 

To change or edit RGB color database: 

1. Run Xconfig. 

2. Double-click on a profile. 

RESULT: A Properties dialog box opens. 

3. Click the Color tab. 

4. In the Color Database area, click Change or View. 

5. Click OK. 
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Using Window Mode 
Xmanager provides a Single Window Mode for XDMCP sessions and a Multiple Window Mode 
for Xstart sessions. In Single Window Mode, the X application opens in a single Xmanager 
window. It is especially usefull when you are runing desktop X applications such as Gnome or 
KDE. Multiple Window mode opens each X application in its own window. It is also referred to 
as Seamless Integration mode beacuase each X application gets an windows frame for resizing 
and minizing just like Windows applications. This mode is useful when you do not need full 
desktop access. You can change the window mode by using Xconfig.  

In a Single Window Mode, you can customize the size of the root window and add a scroll bar 
when the X desktop is larger than your Windows desktop. 

In a Multiple Window Mode, Xmanager helps you to select a window manager and desktop 
background, enable window panning, and activate a window on mouse focus. 

To use single window mode: 

1. Run Xconfig. 

2. Double-click on a profile. 

RESULT: A Properties dialog box opens. 

3. Click the General tab. 

4. In the Choose Window Mode to use list, select Single Window Mode. 

5. Click OK. 

To customize root window size in single window mode: 

1. Run Xconfig. 

2. Double-click on a profile. 

RESULT: A Properties dialog box opens. 

3. Click the General tab. 

4. In the Choose Window Mode to use list, select Single Window Mode. 

5. Click Settings. 

RESULT: A Window Mode Settings dialog box opens. 

6. Click the Single Window Mode tab. 

7. In the Window Size list, select an appropriate size. 

8. Click OK. 

To use multiple window mode: 

1. Run Xconfig. 

2. Double-click on a profile. 

RESULT: A Properties dialog box opens. 

3. Click the General tab. 

4. In the Choose Window Mode to use list, select Multiple Window Mode. 

5. Click OK. 
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To use window panning in multiple window mode: 

1. Run Xconfig. 

2. Double-click on a profile. 

RESULT: A Properties dialog box opens. 

3. Click the General tab. 

4. In the Choose Window Mode to use list, select Multiple Window Mode. 

5. Click Settings. 

RESULT: A Window Mode Settings dialog box opens. 

6. Click the Multiple Window Mode tab. 

7. Select the Use Panning check box. 

8. Click OK. 

To use Auto Raise feature in multiple window mode: 

1. Run Xconfig. 

2. Double-click on a profile. 

RESULT: A Properties dialog box opens. 

3. Click the General tab. 

4. In the Choose Window Mode to use list, select Multiple Window Mode. 

5. Click Settings. 

RESULT: A Window Mode Settings dialog box opens. 

6. Click the Multiple Window Mode tab. 

7. Select the Auto Raise Window check box. 

8. Set Interval. 

9. Click OK. 

To select desktop background in multiple window mode: 

1. Run Xconfig. 

2. Double-click on a profile. 

RESULT: A Properties dialog box opens. 

3. Click the General tab. 

4. In the Choose Window Mode to use list, select Multiple Window Mode. 

5. Click Settings. 

RESULT: A Window Mode Settings dialog box opens. 

6. Click the Multiple Window Mode tab. 

7. In the Background list, select an appropriate background. 

8. Click OK. 

To select a window manager in multiple window mode: 

1. Run Xconfig. 

2. Double-click on a profile. 

RESULT: A Properties dialog box opens. 

3. Click the General tab. 
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4. In the Choose Window Mode to use list, select Multiple Window Mode. 

5. Click Settings. 

RESULT: A Window Mode Settings dialog box opens. 

6. Click the Multiple Window Mode tab. 

7. In the Window Manager list, select an appropriate window manager. 

8. Click OK. 
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Security 
Xmanager supports host-based access control and also supports the public key user 
authentication method using Xstart with the SSH (Secure Shell) protocol. 

Host-based access control manages a trusted hosts list, and only the X applications on the 
trusted hosts can connect to Xmanager. For an unauthorized X application, Xmanager posts 
a warning dialog box to allow the connection or not. Even though the host-based access control 
can prevent connections from unauthorized users, the network packets between Xmanager 
and X applications are not encrypted and vulnerable to intrusion.  

Xmanager also supports SSH protocol for better security. The SSH connection is available only 
for Xstart sessions. 

Xmanager offers password and public key user authentication along with a public key 
generation wizard. Xmanager shares the host key and user key database with Xshell and 
Xftp programs. Therefore, once you have created a user key, Xmanager can use it without 
further configuration steps.  

To enable host-based access control: 

1. Run Xconfig. 

2. Double-click on a profile. 

RESULT: A Properties dialog box opens. 

3. Click the Security tab. 

4. Select the Enable Access Control check box. 

5. In the Trusted Hosts list, enter the hosts you will allow connections. 

6. Click Add. 

7. Click OK. 

To warn for an unauthorized client connection: 

1. Run Xconfig. 

2. Double-click on a profile. 

RESULT: A Properties dialog box opens. 

3. Click the Security tab. 

4. Select the Warn Unauthorized Connections check box. 

5. Click OK. 

To run a remote X application securely with SSH protocol: 

1. Run Xstart. 

2. Click New. 

RESULT: A New Session dialog box appears. 

3. Enter a new session name, and click OK. 

4. In the Host box, enter the hostname or IP address of the remote UNIX/Linux host. 

5. In the Protocol box, select SSH. 

6. To set up SSH protocol-specific options such as public key authentication, select the Public 
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Key option for Authentication and click Setup. 

7. In the Username box, enter the user account on the host. 

8. In the Execution Command box, enter a command that will be executed on the host. For 
example, enter the following to run an xterm: 
/usr/bin/X11/xterm –ls –display $DISPLAY 

9. Click Run. 

To open a user key manager: 

1. Run Xbrowser. 

2. In the Tools menu, click SSH User Key Manager. 

To open a host key manager: 

1. Run Xbrowser. 

2. In the Tools menu, click SSH Host Key Manager. 

To create a user key pair: 

1. Run Xbrowser. 

2. In the Tools menu, click SSH User Key Generation Wizard. 

3. The User Key Generation Wizard will guide you through the whole generation process. 

 Notes 

At the final step of the generation process, you can also register the public key on the 
remote SSH server. 

To register a public key on the server: 

1. Open the User Keys dialog box. 

2. Select the user key you want to register. 

3. Click Properties. 

RESULT: The User Key Properties dialog box appears. 

4. Click the Public Key tab. 

5. In the View public key format as list, select an appropriate format depending on the 
type of your remote SSH server. 

6. Click Save as a file. 

 Notes 

After the public key is saved as a file, you should copy it to the remote server. How to 
register the copied key into your remote SSH account is different for each server and you 
may find it helpful to read “Step 4: Public Key Registration”. 

To import a private key to the database: 

1. Open the User Keys dialog box. 

2. Click Import. 

RESULT: The Open dialog box appears. 

3. Select the private key file you want to import and click OK. 
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4. In the File Type list, select the type of the private key. 

 Notes 

If you select Auto Detect, Xmanager will determine the type automatically. 

5. In the Passphrase box, enter the passphrase of the private key. 

6. Click OK. 

To export a user key to a file: 

1. Open the User Keys dialog box. 

2. Select the user key you want to export. 

3. Click Export. 

RESULT: The Save As dialog box appears. 

4. Enter a file name and click OK. 

 Notes 

The exported file is in the NetSarang User Key format and it cannot be used in the 
applications provided by other vendors. 

To change the name of a user key: 

1. Open the User Keys dialog box. 

2. Select the user key’s name you want to change. 

3. Click Rename. 

 Notes 

Notice that the key name is used as a file name. You must enter only valid characters for 
the name. 

To change the passphrase of a user key: 

1. Open the User Keys dialog box. 

2. Select the user key’s passphrase you want to change. 

3. Click Properties. 

RESULT: The User Key Properties dialog box appears. 

4. Click the General tab. 

5. Click Change Passphrase. 

To delete a user key from the database: 

1. Open the User Keys dialog box. 

2. Select the user key you want to delete. 

3. Click Delete. 
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Multiple Monitors 
Xmanager allows you to select a monitor to open X window desktops when there are multiple 
monitors. You can choose a monitor from available monitors or a virtual screen which includes 
all monitors.  

Make sure all monitors have video color greater than 16 bits, because Xmanager may not 
work correctly if one is 8-bit and others are greater than 8-bit. 

To select a monitor for X desktop: 

1. Run Xconfig. 

2. Double-click on a profile. 

RESULT: A Properties dialog box opens. 

3. Click the Devices tab. 

4. Click Monitor Settings. 

RESULT: A Monitor Settings dialog box opens. 

5. In the Monitor to be used list, select an appropriate monitor. 

6. Click OK. 

To use all monitors as a single X desktop: 

1. Run Xconfig. 

2. Double-click on a profile. 

RESULT: A Properties dialog box opens. 

3. Click the Devices tab. 

4. Click Monitor Settings. 

RESULT: A Monitor Settings dialog box opens. 

5. In the Monitor to be used list, select Virtual Screen. 

 Notes 

The Virtual Screen is shown when your system has multiple monitors. 

6. Click OK. 

To show a monitor selection dialog box at startup: 

1. Run Xconfig. 

2. Double-click on a profile. 

RESULT: A Properties dialog box opens. 

3. Click the Devices tab. 

4. Click Monitor Settings. 

RESULT: A Monitor Settings dialog box opens. 

5. Select the Show the Monitor Selector at startup check box. 

6. Click OK. 
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Copying, Saving and Printing 
X Applications 
Xmanager allows you to copy text between X applications and Windows clipboard 
automatically. You can also copy the image of X application windows to the clipboard, save it as 
a bitmap file or send it to the printer when you are using the local window manager. 

To configure automatic cut & paste: 

1. Run Xconfig. 

2. Double-click on a profile. 

RESULT: A Properties dialog box opens. 

3. Click the Advanced tab. 

4. In the Settings list, select Auto Cut & Paste. 

5. Click OK. 

To copy text area from xterm to Windows Notepad: 

1. In the xterm window, select text area with the left button. 

RESULT: The selected area is highlighted. 

2. Open Notepad. 

3. In the Edit menu, click Paste. 

To copy text area from Windows Notepad to xterm: 

1. In the Notepad window, select text area with the left button. 

RESULT: The selected area is highlighted. 

2. Copy with the keys, Ctrl+C, or the menu options, Edit -> Copy. 

3. Open xterm. 

4. On the xterm window, right-click. 

To copy an X application window to the Clipboard: 

1. In the system menu on the title bar, point to Copy and then click Window or Contents. 

RESULT: The window image is copied to the Clipboard. 

 Notes 

You can use this feature only when you run an application with Xstart, in the Multiple 
Window mode and with a local window manager. 

To save an X application window as a bitmap file: 

1. In the system menu on the title bar, point to Save and then click Window or Contents. 

RESULT: A Save As dialog box opens. 
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2. In the File Name box, enter an appropriate file name. 

3. Click OK. 

 Notes 

You can use this feature only when you run an application with Xstart, in the Multiple 
Window mode and with a local window manager. 

To print an X application window: 

1. In the system menu on the title bar, point to Print and then click Window or Contents. 

RESULT: A Print dialog box opens. 

2. Click Print. 

 Notes 

You can use this feature only when you run an application with Xstart, in the Multiple 
Window mode and with a local window manager. 
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Logging Session 
Xmanager saves the debugging information as a file in user folder. When multiple Xmanager 
sessions are running at the same time, each session generates log messages in a different file 
such as X0.LOG, X1.LOG and so on. The number on the log file indicates the display number of 
an Xmanager session. 

When you experience a problem in using Xmanager, it is helpful to see the log file. 

To view the log file of the current session: 

1. Right-click the Xmanager tray icon or the title bar of Xmanager main window or click the 
small Xmanager icon on the title bar of Xmanager main window. 

RESULT: A Xmanager system menu appears. 

2. In the system menu, point to Log and then click File.  

RESULT: Notepad opens the log file. 

To view the log folder for all sessions: 

1. Right-click the Xmanager tray icon or the title bar of Xmanager main window or click the 
small Xmanager icon on the title bar of Xmanager main window. 

RESULT: A Xmanager system menu appears. 

2. In the system menu, point to Log and then click Folder. 

RESULT: The Log folder opens. 
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Reference 
This section covers complete reference information about using Xmanager. 

Xmanager is a powerful and easy-to-use PC X server software program that is running on a 
Windows platform. It allows you to bring remote UNIX/Linux desktops to your Windows PC 
seamlessly. You can also run remote X applications securely through the SSH (Secure Shell) 
protocol even when your Windows PC is inside a private network and a firewall is between your 
PC and the remote server. 

Xmanager incorporates a variety of new features such as improved user interface, folder 
support and better interopearation with other NetSarang software. It offers many advanced 
options to meet the needs of professional users but also is designed as simply as possible for 
beginners. 

Xmanager consists of a number of programs including Xmanager, Xconfig, Xbrowser, 
Xstart and some additional utilities: 

• Xmanager is a PC X server program, and all X clients will open windows on MS 
Windows through Xmanager. Xstart and Xbrowser execute Xmanager when they 
are trying to run an X application remotely or get a full GUI desktop of a remote Unix. 

• Xconfig creates and manages Xmanager profiles which configure manyXmanager 
options such as window mode, font set, color and so on. 

• Xbrowser is an easy-to-use and very user-friendly interface program for browsing 
remote UNIX/Linux machines and connecting to the remote host through XDMCP 
protocol. It supports multiple XDMCP sessions simultaneously, and the user is able to 
create a shortcut icon for any of the hosts listed in the Xbrowser window. 

• Xstart is a tool that lets you run a remote X application from your PC. It supports 
SSH, TELNET, RLOGIN, REXEC and RSH protocols to log on to a remote host, and it 
executes a remote command as easily as it is on your Windows PC. 
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Xmanager 
Xmanager is an X server that brings remote X applications to Windows desktop. 

Xmanager is a display server program running on the user’s desktop. When you run a remote 
X application on Unix, it connects to Xmanager and sends various requests such as 
CreateWindow, PolyLines, PolyText and so on. Xmanager processes those requests on 
Windows desktop and delivers user inputs such as mouse click and key press to the X 
application. 

By default Xmanager listens on the port, TCP 6000 for X applications. If you run another 
Xmanager, it will try to search another port greater than TCP 6000 for an unused one.  

When you open multiple Xmanager sessions, each session gets a unique display number 
starting from 0 and it is displayed on the title bar of Xmanager such as [:0.0]. The first digit is 
the display number and the second one is the screen number. The screen number is always 0. 
Xmanager adds 6000 to the display number to get a TCP port. If it listens on TCP 6001, the 
display number will be 1. 

If you run Xmanager from the Programs folder of the Start menu, Xmanager goes to an idle 
state and it waits for an X application to connect. Then, you can run a remote X application 
using Xstart or other tools. For Xstart sessions, Xmanager reads the default Xstart profile 
specified in Xconfig. 

When Xstart executes a remote X application, it runs Xmanager before sending the 
command to the remote host. So, you do not need to run Xmanager ahead of time. 

If you run Xmanager Broadcast from the Programs folder of the Start menu, Xmanager 
broadcasts an XDMCP query message on the network. Any hosts which respond to the query 
will be displayed on a chooser window, and you can select one to connect to the host with 
XDMCP. For XDMCP sessions, Xmanager reads the default XDMCP profile specified in Xconfig. 

In a multiple window mode, Xmanager icon goes into the system tray. You can right-click on 
the tray icon to open a system menu. In the system menu, you can run other utilities, see the 
logs and open the Xmanager Help system. For example, see the figure below: 
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Figure 9: Xmanager Multiple Window Mode 

In a single window mode, Xmanager opens a large main window in which X application 
windows appear, as the figure below shows. 
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Figure 10: Xmanager Single Window Mode 

Xmanager system menu 
In the Xmanager system menu, you can run other utility programs, open a log file, open the 
Properties dialog box and get Xmanager Help system. You can open the menu by clicking the 
Xmanager icon on the title bar. 
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Figure 11: Xmanager System Menu 

Restore 

Returns the window to its original size when it is maximized or minimized. 

Move 

Moves the window. 

Size 

Changes the size of the window. 

Minimize 

Iconizes the window. 

Maximize 

Maximizes the size of the window. 

Close 

Terminates all X applications connected to Xmanager and closes Xmanager. 

Server Reset 

Terminates all X applications connected to Xmanager and resets Xmanager in its initial state. 

Tools->Xbrowser 

Runs the Xbrowser program. 
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Tools->Xstart 

Runs the Xstart program. 

Tools->Xconfig 

Runs the Xconfig program. 

Client 

Starts Xstart session 

Log->File 

Opens the log file of this session. 

Log->Folder 

Opens the log folder for all Xmanager sessions. 

Help->Xmanager Help 

Opens the Xmanager Help system. 

Help->About Xmanager 

Opens the About dialog box which contains version and license information. 

Properties 

Opens the Properties dialog box for the Xmanager profile of this session. 

Xmanager tray menu 
In the Xmanager tray menu, you can run other utility programs, open a log file, open the 
Properties dialog box and get Xmanager Help system. You can open the menu by clicking the 
Xmanager icon on system tray. 

 

Figure 12: Xmanager Tray Menu 



 

Reference   |   59 

Close 

Terminates all X applications connected to Xmanager and closes Xmanager. 

Minimize All 

Iconizes or hides all X application windows. 

Restore All 

Restores all X application windows to its original position and size. 

Server Reset 

Terminates all X applications connected to Xmanager and resets Xmanager in its initial state. 

Tools->Xbrowser 

Runs the Xbrowser program. 

Tools->Xstart 

Runs the Xstart program. 

Tools->Xconfig 

Runs the Xconfig program. 

Client 

Starts Xstart session  

Log->File 

Opens the log file of this session. 

Log->Folder 

Opens the log folder for all Xmanager sessions. 

Help->Xmanager Help 

Opens the Xmanager Help system. 

Help->About Xmanager 

Opens the About dialog box which contains version and license information. 

Properties 

Opens the Properties dialog box for the Xmanager profile of this session. 

Xmanager command line options 
Xmanager supports command line options to interface with other user applications. When you 
run Xmanager directly, it does not read an Xstart or Xbrowser session and you should 
specify the connection method and display number as command line options. 

Xmanager command line usage: 

Xmanager [-query hostname|-broadcast|-indirect hostname] [:digit] 

Some examples are listed below. 
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Usage Description 

Xmanager Runs as a passive mode with the default Xstart 
profile. The display number is 0 by default; if it is 
not available, another number is allocated 
automatically. 

Xmanager :1 Runs as a passive mode with the default Xstart 
profile. The display number is 1; if it is not 
available, Xmanager aborts. 

Xmanager –query host Connects to the host with the XDMCP query 
method. It uses the default XDMCP profile. The 
display number is 0 by default; if it is not 
available, another number is allocated 
automatically. 

Xmanager –query host :2 Connects to the host with the XDMCP query 
method. It uses the default XDMCP profile. The 
display number is 2; if it is not available, 
Xmanager aborts. 

Xmanager –broadcast Sends an XDMCP broadcast message to the local 
network and displays all available XDMCP hosts in 
a Chooser dialog box. It uses the default XDMCP 
profile. The display number is 0 by default; if it is 
not available, another number is allocated 
automatically. 

Xmanager –indirect host Connects to the host with the XDMCP indirect 
method. The remote host opens a chooser window 
through Xmanager. It uses the default XDMCP 
profile. The display number is 0 by default; if it is 
not available, another number is allocated 
automatically. 



 

Reference   |   61 

Xbrowser 
Xbrowser is an easy-to-use and very user-freindly interface program for browsing remote 
UNIX/Linux machines which support XDMCP connections. By default it broadcasts an XDMCP (X 
Display Manager Control Protocol) query message to all the hosts in your local network and 
displays the hosts that respond to the query message. 

To connect to a host, you can simply double-click on the host icon displayed in the Xbrowser 
window. Actually Xbrowser executes Xmanager with the hostname you selected. Xbrowser 
is able to run multiple Xmanager to get multiple XDMCP sessions simultaneously. Each XDMCP 
session launched by Xbrowser has a unique display number which starts from zero. 
Xmanager allocates a display number for each XDMCP session automatically and you do not 
have to worry about configuring the display number. 

Xbrowser allows you to create a new XDMCP session by copying existing one or using New 
Session Wizard. Once you create a new session, it is stored on your PC and you can change its 
options or create a shortcut of the session. 

Xbrowser can also create and display Xstart sessions. All Xstart sessions are shared by 
Xstart and Xbrowser. You can show or hide Xstart sessions on your preference. 

Xbrowser main window 
Xbrowser main window looks like a Windows Explorer. It consists of a menubar, a toolbar, 
an address bar, a workspace, and a status bar, as shown in the figure below. 

  



 

62   |   Reference 

Figure 13: Xbrowser Main Window 

The workspace displays the hosts which respond to an XDMCP query message. An icon on the 
workspace denotes the type of a session. Xbrowser supports three kinds of sessions: 
Dynamic, Static and Xstart. 

The list below describes each session. 

Icon Session Type Description 

 

Dynamic Xbrowser sends a broadcast message on local LAN and finds these 
sessions dynamically. To find hosts in another subnet, you can add 
IP addresses in the Options dialog box. 
All dynamic sessions have the same configuration. To change the 
configuration of a session, right-click on the session, click Save As, 
right-click on the newly created session and then click Properties. 

 

Static A Static session is bound to a specific remote host. You can create it 
by copying from a dynamic session or using New Session Wizard. If 
the remote host does not respond to the XDMCP query message, the 
icon appears dimmed. 
Passive and XDMCP broadcast sessions are also considered to be 
static sessions. 
You can create a shortcut of a session, save as a file, configure its 
options or send it to another user via email. 

 

Xstart Xbrowser can create and manage Xstart sessions. You can also 
create these sessions in the Xstart program on your preference. 
Xbrowser and Xstart share all Xstart sessions. 
By double-clicking an Xstart session, you can run a remote X 
application as easily as it is on your Windows machine. 

Xbrowser sends broadcast messages periodically and refreshes the workspace appropriately. 
By default the refresh cycle is 300 seconds. If a host does not respond to the message in a few 
seconds, the icon is changed to a dim shape. 

In general, all UNIX/Linux systems support XDMCP service, and there should be no problem in 
finding a remote host in the Xbrowser window. In some cases, the remote host is not 
configured to service XDMCP requests and that makes the host not to be found on the list. 
Then you should contact your system administrator to set up XDMCP service in the remote 
host. 

By default Xbrowser does not search a host that resides in another network segment. To 
search the host, you should add its IP address in the Options dialog box. Be sure that XDMCP 
connection does not work if a firewall exists between your Windows and the remote host. 

File menu 
In the File menu, you can create and open sessions, create a shortcut of a session and view 
the properties of a session. 



 

Reference   |   63 

 

Figure 14: Xbrowser File Menu 

New->New Session Wizard 

Opens the New Session Wizard. You can create an Xmanager or Xstart session using the 
wizard. 

New->Static Session 

Creates an Static session on the workspace. You can change its name and configure its 
options. 

New->Xstart Session 

Creates an Xstart session on the workspace. You can change its name and configure its 
options. You can also edit the newly created session in the Xstart program. 

New->Xshell Session 

Creates an Xshell session if Xshell is installed. You can change session name and configure its 
options.  

New->Xftp Session 

Creates an Xftp session if Xftp is installed. You can change session name and configure its 
options.  

New->Folder 

Creates a new folder.  

Open 

Opens the selected session. Xbrowser executes Xmanager with the information in the 
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session. 

Save As 

Saves the selected session as another name. 

Delete 

Deletes the selected session from the workspace. 

Rename 

Changes the name of the selected session. 

Create Shortcut 

Opens the Browse for Folder dialog box and create a shortcut on the folder you selected. 

Sharing 

Shares the session with all users in the system. Only the users who have an administrative 
privilege can use this command. Shared session is moved to the Shared folder. 

Send To->Mail Recipient 

Opens a mail composer with the session attached to the message. It is useful when an 
administrator creates a template session and wants to distribute it to other users. The 
Password value in the session is not readable by other users. 

Send To->Desktop (create shortcut) 

Creates a shortcut for a session on the Desktop folder. 

Import 

Opens the Import session wizard. You can import sessions. 

Export 

Opens the Export session wizard. You can export sessions. Password are not included in the 
exported sessions. 

Properties 

Opens the Xbrowser Properties dialog box for the selected session. 

Exit 

Quits the Xbrowser program. 

Edit menu 
In the Edit menu, you can copy, paste and select profiles. 
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Figure 15: Xbrowser Edit Menu 

Cut 

Moves the selected sessions and folders to the clipboard. 

Copy 

Copies the selected sessions and folders to the clipboard. 

Paste 

Pastes the sessions in the clipboard to current folder. 

Select All 

Selects all sessions and folders in the current folder. 

View menu 
In the View menu, you can show or hide Toolbars and Status Bar, change the listing style of 
the workspace and adjust columns in Details view. 

 

Figure 16: Xbrowser View Menu 
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Toolbars->Standard Buttons 

Shows or hides the standard buttons. 

Toolbars->Address Bar 

Shows or hides the Address bar. 

Toolbars – Lock the toolbars 

Locks or unlocks toolbars from changing position. 

Session Bar 

Shows or hides the Session window where you can manange not only Xmanager sessions 
but also Xshell, Xftp sessions. 

Status Bar 

Shows or hides the Status Bar. 

Large Icons 

Changes the listing style to the Large Icons view. 

Small Icons 

Changes the listing style to the Small Icons view. 

List 

Changes the listing style to the List view. 

Details 

Changes the listing style to the Details view. 

Sessions->XDMCP Sessions 

Opens the XDMCP session root node. 

Sessions->Xstart Sessions 

Opens the Xstart session root node. 

Sessions->Xshell Sessions 

Opens the Xshell session root node. 

Sessions->Xftp Sessions 

Opens the Xftp session root node. 

Columns 

Opens the Columns dialog box. You can customize the columns that will be displayed in 
Details view. 



 

Reference   |   67 

Find Hosts 

Sends out the broadcast message to local network and the hosts specificed in the Options 
dialog box.  

Refresh 

Sends a broadcast message to your local network and the registered hosts, then refreshes the 
session list accordingly. 

Tools menu 
In the Tools menu, you can run Xstart and Xconfig programs, create and manage SSH user 
keys, and configure Xbrowser options. 

 

Figure 17: Xbrowser Tools Menu 

Launch Xstart 

Runs the Xstart program. 

Launch Xconfig 

Runs the Xconfig program. 

SSH Host Key Manager 

Opens the Host Keys dialog box. 

SSH User Key Manager 

Opens the User Keys dialog box. 

SSH User Key Generation Wizard 

Opens the User Key Generation Wizard. 

Options 

Opens the Options dialog box. The dialog box allows you to edit broadcast addresses and 
change the refresh interval. 
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Help menu 
In the Help menu, you can open Xmanager Help system and get information about the 
current version. 

 

Figure 18: Xbrowser Help Menu 

Contents and Index 

Opens Xmanager Help system. 

Online Support 

Opens an Internet browser and goes to the support page of Xmanager. 

Check for Updates 

Checks the newest version of Xmanager to help with upgrading it. 

About Xbrowser 

Opens the About dialog box which contains the version and license information. Also in this 
dialog box you can enter product keyto register Xmanager. 

Session Context Menu 
By clicking right mouse button in a session, you can open Session Context Menu. 
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Figure 19: Session Context Menu 

Open 

Opens the selected session. If multiple sessions are selected, all of selected sessions are 
opened. 

Open All Subsessions  

Opens all sessions saved under the selected folder. 

Open With->SSH 

Opens Xshell (terminal emulator) and makes SSH connection to the selected host. 

Open With->TELNET 

Opens Xshell (terminal emulator) and makes TELNET connection to the selected host. 

Open With->RLOGIN 

Opens Xshell (terminal emulator) and makes RLOGIN connection to the selected host. 

Open With->FTP 

Opens Xftp (file transfer client) and makes FTP connection to the selected host. 

Open With->SFTP 

Opens Xftp (file transfer client) and makes SFTP connection to the selected host. 

Save As 

Copies the selected session to a new session. If it is XDMCP dynamic session, it will be saved 
as XDMCP static session. 
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Save as SSH connection 

Creates Secure XDMCP static session if it is XDMCP dynamic session. In this case SSH server 
must be running on the remote host. 

Sharing 

Starts/Stops sharing the selected session with other users of the system. Shared session is 
moved to the Shared folder.  

Send to 

Sends the selected session file to other users through email or creates a shortcut in the 
desktop folder. 

Create Shortcut 

Opens the Browse for Folder dialog box and allows you to create a shortcut for the current 
session. 

Delete 

Deletes the selected session. 

Rename 

Changes the name of the selected session. 

Properties 

Opens Properties dialog box to change settings of the session. 

Toolbar buttons 
Xbrowser provides a number of toolbar buttons for commonly used tasks and commands. You 
can also perform the same tasks from the menu bar. 

 

 

Figure 20: Xbrowser Toolbar Buttons 

The list below describes the toolbar buttons. 

Button Name Description 

 
New Opens New Session Wizard. It allows you to create Xstart or 

XDMCP sessions step by step. 

 
Open Starts the selected session. You can also start terminal 

session and file transfer session by selecting the submenu. 

 Delete Deletes the selected session. 

 
Properties Opens the Xbrowser Properties dialog box for the selected 

session. 
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 Session bar Shows the Session bar. 

 Back Moves to backward in the visited folders. 

 Forward Moves to forward in the visited folders 

 Up one level Moves up one level in folder tree 

 Cut Cuts the selected sessions and folders 

 Copy Copies the selected sessions and folders to the Clipboard 

 Paste Pastes the sessions and folders from the Clipboard 

 Find hosts 
Sends out the broadcast message to local network and the 
hosts specificed in the Options dialog box.  

 View Changes the listing style of the workspace. 

 
Options Opens the Options dialog box and allows you to configure 

Xbrowser options. 

 Help Opens the Xmanager Help system. 

Address bar 

 

Figure 21: Xbrowser Address Bar 

The syntax in the Address bar is: 

 hostname 

 xdmcp://hostname 

xstart://sessionname 

xsession://sessionname 

ssh://[username[:password]@]hostname[:port][/] 

telnet://[username[:password]@]hostname[:port][/] 

rlogin://[username[:password]@]hostname[:port][/] 

ftp://[username[:password]@]hostname[:port][/] 

sftp://[username[:password]@]hostname[:port][/] 

Available protocols are xdmcp, xstart, xsession, ssh, telnet, rlogin, ftp and sftp. The xdmcp 
protocol is used when a protocol is not specified. The xdmcp protocol uses UDP port 177 as a 
default port. 

Some examples are listed below. 

Usage Description 

foobar.com 
xdmcp://foobar.com 

Connects to the foobar.com using XDMCP protocol. 
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xstart://mysession Opens an Xstart session named mysession. 

xsession://cdesession Opens a static Xbrowser session named cdesession. 

ssh:// myhost:22/ Opens Xshell and it connects to myhost, port 22 with 
SSH protocol. The Xshell program must be installed in 
your Windows to be able to run an SSH command. 

telnet://user:pass@myhost Opens Xshell and it connects to myhost, port 23 with 
TELNET protocol. The username and password are sent 
automatically after connected. The Xshell program must 
be installed in your Windows to be able to run a telnet 
command. 

rlogin://user@myhost Opens Xshell and it connects to myhost, port 513 with 
RLOGIN protocol. The username is sent automatically 
after connected. The Xshell program must be installed in 
your Windows to be able to run an RLOGIN command. 

ftp://anonymous@myhost Opens Xftp and it connects to myhost, port 21 with FTP 
protocol. The username is sent automatically after 
connected. The Xftp program must be installed in your 
Windows to be able to run an FTP command. 

sftp://user:pass@myhost/ Opens Xftp and it connects to myhost, port 22 with SFTP 
(Secure Shell File Transfer Protocol) protocol. The 
username and password are sent automatically after 
connected. The Xftp program must be installed in your 
Windows to be able to run an SFTP command. 

Options dialog box 
The Options dialog box allows you to specify broadcast addresses and a refresh interval. You 
can open the dialog box by clicking Options on the Tools menu. 

XDMCP tab 
In the XDMCP tab, you can set XDMCP broadcast options and specify the hosts to exclusively 
search for when sending out the broadcast message. 
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Figure 22: Xbrowser Options Dialog Box, XDMCP Tab 

Search for local UNIX hosts 

Xbrowser sends a broadcast packet to the local broadcast address, 255.255.255.255, UDP 
port 177. Thus, all hosts in the local network listen the packet at the same time. This feature is 
a very efficient way to send a small packet to all hosts in the local network simultaneously. 

If your local network has too many hosts and you want to limit the hosts displayed in the 
Xbrowser window, turn off this option and add your preferred hosts to the Registered 
Addresses list. 

Check for host availability every __ seconds 

Select this check box if you want to update the state of each session periodically. At the 
intervals you specified, Xbrowser sends a broadcast message again and refreshes the 
workspace accordingly. 

Exclusively search for the following hosts 

Enter the IP address or hostname of the remote host you want to browse for XDMCP 
connection. By default, Xbrowser searches for all UNIX/Linux hosts in the same local network. 
If some hosts are outside the local network, you can add them here. 

To send a broadcast message to another network, set the host number part of the IP address 
to all ones. For example, when you want to search for all hosts in 192.168.1.xxx, add 
192.168.1.255 to the list. This works for most networks, but some routers do not allow 
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broadcast feature across networks. 

Add 

Adds a new address to the Registered Addresses list. 

Registered host list  

Xbrowser sends an XDMCP broadcast message to the hosts in this list. 

Remove 

Removes the selected host from the Registered Addresses list. 

Sessions tab 
In the General tab, you can set XDMCP and connection address settings of a session 

 

 

Figure 23: Xbrowser Options Dialog Box, Sessions Tab 

Figure 24: Xbrowser Options Dialog Box 

Show Shared folder 

Displays the Shared folder node on the Session bar.  
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Show Xshell sessions 

Displays the Xshell node on the Session bar. 

Show Xftp folder 

Displays the Xftp folder on Xbrowser.  

Session Path 

Defines the root session directory for XDMCP and Xstart sessions. For example, you can set a 
network folder as the session path and share the sessions with other users.  

XDMCP 

Sets where the XDMCP sessions are saved. 

Xstart  

Sets where the Xstart sessions are saved. 

Xbrowser Properties dialog box 
The Properties dialog box allows you to customize the settings of a session. You can open it 
by clicking Properties on the File menu or the Properties button on the toolbar. 

In the dialog box, you can configure XDMCP settings, a connection address, a server profile 
and a display number. 

General tab 
In the General tab, you can set XDMCP and connection address settings of a session. 
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Figure 25: Xbrowser Properties Dialog Box, General Tab 

Connection Method 

Select one of connection methods: Passive (No XDMCP), XDMCP Query, XDMCP Broadcast 
XDMCP Indirect, and Secure XDMCP. 

Passive method just executes Xmanager in background mode. By default, Xmanager enters 
into the system tray and waits for X applications to connect. It is useful when you want to run 
Xmanager ahead and open X applications using Xstart or a telnet client. 

XDMCP Query is a default method for dynamic sessions. It connects to the specified host 
directly and brings a graphic login window to your Windows. 

XDMCP Broadcast is a method that Xmanager opens a Broadcast Chooser dialog box which 
looks like a simple Xbrowser. 

XDMCP Indirect is a similar method to XDMCP Broadcast except that the Chooser dialog box is 
displayed by the remote host, not by Xmanager. 

Secure XDMCP is useful when Xmanager cannot establish XDMCP connection because of 
private network with firewall. If SSH server is running on the remote server, you can make 
XDMCP connection to the remote host using SSH tunneling. 

XDMCP 

Enter the name of the session. This text is displayed on Xbrowser as the name for the 
session.  
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Host 

Enter the IP address or hostname of the remote host you want to connect to. 

Make sure that a display manager is running on the remote host. Most unix machines are using 
one of dtlogin, kdm, gdm and xdm as the display manager. 

Port Number 

Enter the port number of the remote display manager. The default value is UDP port 177.  

Use Default 

Sets the port number to UDP port 177. 

Local Address 

Select one of the IP addresses of your Windows. This option is used only your Windows has 
multiple IP addresses. 

If you select Auto Select in the list, Xmanager tries to find an appropriate IP address for the 
connection. When Xmanager fails to find an appropriate one, it displays an IP Selector dialog 
box in which you can select a correct one. 

The display manager on the remote host will connect to the IP address you have selected. If 
you choose an inappropriate IP address, the display manager cannot get access to Xmanager 
and fails to open a login window. 

Connection address 

This option is required when you connect using port forwarding in a limited network 
environment such as firewall or proxy server, and when Secure XDMCP is selected and 
automatic connection address feature malfunctions due to XDM server settings, etc. When your 
Windows resides in a private network with a firewall, Xmanager cannot get a remote login 
window with an XDMCP connection. It is because that the firewall blocks incoming connections 
and the remote display manager cannot reach at Xmanager on your Windows. 

To use this feature, you need to allocate a listening port in the firewall and forward incoming 
connections to your Windows. 

 

Address Type 

If you wish to make XDMCP connection in a limited network environmnet with proxy server 
or firewall, select User Defined. In case of Secure XDMCP, if Auto Select of connection 
address fails, select IP address or loopback address (127.0.0.1) of SSH server. 

IP Address 

If Connection Address is User Defined mode, type in IP address of the proxy server or 
firewall server. The remote display manager connects to this address, and the proxy server 
forwards the connection to your Windows. 

Port Number 

If Connection Address is User Defined mode, enter a TCP port number you allocated in 
the proxy server. 

As an example, let us assume that your Windows has a private IP address, 192.168.1.100 and 
the firewall server has a private IP address, 192.168.1.1. The firewall has also a public IP 
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address, 210.100.xxx.10 for Internet connections and the IP address of a remote Unix host is 
210.100.xxx.100. 

In this case, you need to configure the firewall to forward incoming connections 
(210.100.xxx.10, 6010) to Xmanager (192.168.1.100, 6010) on your Windows. This is called 
port forwarding and you should contact your administrator to configure it. 

Now, enter 210.100.xxx.100 in the Host box of the Connection area, select User Defined as 
Address Type in Connection Address area, enter 210.100.xxx.10 in the IP Address box, and 
then enter 6010 in the Port Number box. Click the X Server tab, turn off the Allocate 
display number automatically option, and then enter 10 (It means the TCP port 6010) in 
the Display Number box.  

X Server tab 
In the X Server tab, you can select a server profile and allocate a display number manually. 

 

Figure 26: Xbrowser Properties Dialog Box, X Server Tab 

Server Profile 

Select an Xmanager profile for this session. A server profile defines a window mode, fonts and 
other Xmanager options for advanced users and you can create a new profile using Xconfig 
utility. 
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Configure 

Opens a Properties dialog box for the selected profile. You can change Xmanager options in 
the dialog. Be aware that the changes will affect all sessions using the same server profile. 

Allocate display number automatically 

Select this check box for automatic allocation of a display number. By default, Xmanager tries 
to listen on  TCP port number 6000, and if the port is already being used, it tries to open 
another port in the range of 6001 ~ 6255. 

If you need to fix a specific port for this session, clear this check box, and enter an appropriate 
display number in the Display Number box. 

Display Number 

Enter a display number in this box. A display number should be in the rage of 0 ~ 255. When 
you open multiple Xmanager sessions, each session gets a unique display number starting 
from 0 and it is displayed on the title bar of Xmanager such as [:0.0]. The first digit is the 
display number and the second one is the screen number. The screen number is always 0. 

Xmanager adds 6000 to the display number to get a TCP port. If you enter 10 on the Display 
Number box, Xmanager will open a TCP port 6010 to communicate with X applications. 

Be aware that some Unix machines do not understand 3-digit display numbers, and it is safe to 
use a number less than 100. 

New Session Wizard 
The New Session Wizard allows you to create Xstart and XDMCP sessions step by step. You 
can open it by pointing to New on the File menu and then clicking New Session Wizard. 
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Figure 27: Xbrowser New Session Wizard 

The New Session Wizard is a simple way to create both Xstart and XDMCP sessions for 
beginners. For advanced users, an Xstart program is available to create and manage Xstart 
sessions. 

The New Session Wizard provides three types of sessions: Xstart, XDMCP and Passive. 

Xstart sessions are useful when you want to run a remote X application. Once you create an 
Xstart session, you can run a remote X application such as an xterm in one click as you run a 
Windows application. It connects to the remote host and run a specified command 
automatically to open a remote X application on your Windows. 

XDMCP sessions are used to get a graphic login window and full desktop environment of the 
remote host. Xmanager supports CDE, KDE, GNOME and all other GUI desktops for 
UNIX/Linux machines. 

Passive sessions are used when you want to run Xmanager ahead and run X applications later 
using Xstart or any terminal program such as telnet. When Xmanager starts, it just sits idle 
and waits for connections from X applications. 

Session Import Wizard 
The Session Import Wizard allows you to import sessions that are created from previous or 
different versions of Xmanager. You can start the wizard by clicking Import from the File 
menu. 
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Step 1: Select import mode 
In this step, choose how you want to import sessions. 

 

Figure 28: Session Import Wizard, Step 1 

From the previously installed products on this computer 

Select this option if you want to import sessions from the previously installed Xmanager 
versions on the same computer. 

From the following location 

Select this option to import the sessions with an exported session file from another computer. 

Step 2: Select sessions to import  
In this step, choose sessions that you want to import 
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Figure 29: Session Import Wizard, Step 2 

Source 

All sessions that are created from the different versions of Xmanager are listed. Select 
sessions you want to import 

Type 

Shows the session type such as Xstart session and Static session. 

Count 

Shows the number of sessions that will be imported for the product.  

Step 3: Importing sessions 
You can view the progress and status of the current import process. 
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Figure 30: Session Import Wizard, Step 3 

Progress 

You can view the progress of import process. As each session is copied, its result is displayed 
on the screen. Also, number of files imported is summarized at the end of the process. 

Session Export Wizard 
The Session Export Wizard allows you to export sessions. You can start the wizard by 
clicking Export from the File menu. 

Step 1: Select sessions to export 
In this step, select the products to export its sessions. 
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Figure 31: Session Export Wizard, Step 1 

Source 

All sessions that will be exported are listed. Select sessions you want to export. 

Type 

Shows the session type such as Xstart, Static, Xshell and Xftp sessions. 

Count 

Shows the number of sessions that will be exported for the product.  

Step 2: Select where to save the exported file 
In this step, you can select the name and folder in which the exported file will be saved. 
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Figure 32: Session Import Wizard, Step 3 

Path 

Enter the filename and path in which the exported session file will be saved. 

Step 3: Exporting sessions 
You can view the progress and status of the current export process. 
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Figure 33: Session Export Wizard, Step 3 

Progress 

You can view the progress of export process. As each session is copied, its result is displayed 
on the screen. Also, number of files imported is summarized at the end of the process. 

Columns dialog box 
The Columns dialog box allows you to adjust the columns of Xbrowser when it is in Details 
view. You can open the dialog box by clicking Columns in the View menu. 
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Figure 34: Xbrowser Columns Dialog Box 

Columns 

Shows the columns you can display in the Xbrowser window. Check or uncheck a column 
name to show or hide it. 

The list below describes the columns. 

Column Name Description 

Name This column shows the name of each session. 

Address The IP address of a remote host. 

Protocol The connection protocol for each session. 

Port The connection port for each session. 

X Profile Xmanager profile that will be used for the session. 

X Profile Path The path of the Xmanager profile. 

Display The display number Xmanager will use. 

Status The system status message received from the remote display manager. 
This column is applicable only to XDMCP sessions. 

User Name Login account on a remote host. This column is applicable only to 
Xstart sessions. 

Command The command that will be executed automatically. This column is 
applicable only to Xstart sessions. 

Created The creation time of a session. 

Accessed The last access time of a session. 
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Modified The last modification time of a session. 

Move Up 

Moves the selected column by one to the top. 

Move Down 

Moves the selected column by one to the bottom. 

Show 

Shows the selected column. The column appears in the Xbrowser window. 

Hide 

Hides the selected column. The column disappears from the Xbrowser window. 

Reset 

Restores the default configuration of the Columns list. 

The selected column should 000 pixels wide 

Enter an appropriate width of the selected column in the pixels unit. 

Secure XDMCP Setup dialog box 
In Secure XDMCP Setup dialog box, you can configure SSH connection of Secure XDMCP 
static session. To open the dialog box, in General tab of Xbrowser Session Properties 
dialog box, select Secure XDMCP for Connection Method, then click Setup.  

SSH tab 
In SSH tab, you can configure connection settings and user authentication for SSH connection.  
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Firgure 35: Xbrowser Secure XDMCP Setup dialog box, SSH tab 

The SSH server host is different from XMDCP server.  

Secure XDMCP is a connection method that X clients connects to Xmanager of PC through 
SSH tunneling. If SSH server is not running on XDM host server, a proxy server for SSH 
tunneling is required. This option is to configure this SSH proxy server.  

Host 

Enter hostname or IP address of the proxy server for SSH tunneling. In this case, you need 
to configure SSH proxy server so that it can bind to not only loopback address(127.0.0.1) 
but external connections.  

 

For more information about Secure XDMCP Setup dialog box, see “SSH Protocol Setup 
dialog box, The General tab”. 
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Options tab 
In Options tab, you can configure security, performance and pseudo terminal options.  

 

Figure 36: Xbrowser Secure XDMCP Setup dialog box, Options tab 

Fore more information about Options tab, see “SSH Protocol Setup dialog box, The 
Options tab”. 

Tunneling tab 
In Tunneling tab, you can set TCP/IP, Dynamic forwarding and X11 Forwarding rules. For 
these options to take effect, connection protocol must be set to SSH in Connection.  
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Figure 37: Xbrowser Secure XDMCP Setup dialog box, Tunneling tab 

Fore more information about Tunnel tab, see “SSH Protocol Setup dialog box, The 
Tunneling tab”. 

Xstart 
Xstart is a tool that lets you run an X application of a remote host from your Windows. Xstart 
automatically processes the login steps to the remote host and runs any X application you 
specified. It is a handy and powerful tool to bring a remote X application to your Windows 
desktop. 

Xstart supports a lot of connection protocols: SSH, TELNET, RSH, REXEC, RLOGIN and LOCAL. 
It provides SSH protocol for secure connections as well as other protocols for legacy systems. 
Using the SSH protocol, you can run any X applications over a secure tunnel even if there is a 
firewall between your Windows and the remote host. 

Xstart provides a simple interface to create a session for each remote command. All Xstart 
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sessions created here will also be available in the Xbrowser program. You can create a 
shortcut for a session on any Windows folder, and run the remote command with just one click 
such as you run a Windows application. 

When you run a session, Xstart executes Xmanager first and then sends a command to the 
remote host. You do not have to run Xmanager ahead. But if an Xmanager program is 
already running and it is using the same server profile with the session, Xstart will not execute 
another Xmanager. 

Xstart main window 
The Xstart main window allows you to create, save, delete and run sessions. 

In order to run Xstart, click the Start menu, point to Programs, point to Xmanager2 and 
then click Xstart. 

 

Figure 38: Xstart Main Window 

Session 

Select a session you want to edit or run. To create a new session, click New. 

Host 

Enter the IP address or hostname of the remote UNIX/Linux host. It is faster and more stable 
to enter an IP address than a hostname, because Xstart does not have to connect to a name 
server. 
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Protocol 

Select a protocol that will be used for connecting to a remote host. Xstart supports SSH, 
TELNET, RSH, REXEC, RLOGIN and LOCAL protocols. Before selecting a protocol, confirm that 
the remote host is configured to support it. 

SSH is a protocol for a secure connection to a remote host. It offers public key user 
authentication, strong data encryption and X11 forwarding features. Using SSH protocol, you 
can run remote X applications with strong encryption over insecure network. It also makes it 
easy to have connection with remote hosts beyond a firewall, thus one who is in a private 
network can run X applications in another network using X11 forwarding. 

TELNET is a legacy protocol for remote terminal emulation. Xstart supports it for the hosts 
that do not have an SSH server. TELNET is supported in most hosts including Unix, Linux and 
VMS, so you can take advantage of it when the hosts do not support other protocols. 

RSH is a simple protocol to connect to a remote host and run a specified command. It does not 
require a password and be careful in using it for security. For more information about RSH, 
refer to the man page of the rsh command from the remote host. 

REXEC is a remote execution protocol to run a command on a remote host. It does the same 
thing with the RSH protocol, but requires a password for a connection. In addition it is simpler 
to use than RSH. 

RLOGIN is a simple remote shell protocol to connect to a remote host and get a login shell. It is 
similar to TELNET but user authentication works the same way as RSH. For more information 
about RLOGIN, refer to the man page of the rlogin command from the remote host. 

LOCAL is used when an X application is installed on your Windows, not on a remote host. 

Setup 

Opens a Protocol Setup dialog box for the selected protocol. You can configure a connection 
port, time-out value and other options specific to the protocol. 

Username 

Enter the user account on the remote host. 

Authentication 

Select a user authentication method. You can choose one of Password, Public Key and 
Keyboard Interactive. The method you selected will be tried first, and when it fails, you can 
change to another one during logon process. 

Save (Check Box) 

Select this check box when you want to save the password. For security reasons, it is not 
recommended. 

Execution Command 

Enter a remote command to run on the remote host. 

As an example, when you want to run an xterm the command looks like: 

/usr/bin/X11/xterm –display $DISPLAY 

For SSH and TELNET protocols, you can remove the “-display $DISPLAY” option from the 
command. 

The “$DISPLAY” variable is converted to an appropriate value by Xstart. In general, it is 
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converted to “192.168.1.100:0.0” when the IP address of your Windows is “192.168.1.100”. If 
you want to specify the value explicitly, enter the command as in the following: 

/usr/bin/X11/xterm –display 192.168.1.100:0.0 

Xstart also understands the “$PCADDR” variable and converts it to the IP address of your 
Windows. For an example: 

/usr/bin/X11/xterm –display $PCADDR:0.0 

When your Windows has multiple IP addresses, Xstart selects an appropriate one 
automatically. 

Registered Commands (Arrow Button) 

Click this button to select a predefined command on a menu. By selecting a command on the 
menu, you can enter a long command just with a single click. 

Click Add/Remove to open the Registered Commands dialog box, which allows you to add 
frequently used commands on the menu. 

Show reply messages 

Select this check box when you want to see the reply messages from the remote host. It is 
useful when Xstart fails to run a remote X application successfully. 

Advanced 

Opens the Xstart Advanced Options dialog box. You can configure a server profile and 
advanced prompt options in the dialog box. 

New 

Opens the New Session dialog box. Click this button to create a new session. 

Save  

Saves changed values of the current session. 

Save As (Down Arrow Button) 

Copies the current session to a new session. Any changes in the current session apply only to 
the new session. 

Delete 

Deletes the current session permanently. 

Shortcut (Down Arrow Button) 

Opens the Browse for Folder dialog box and allows you to create a shortcut for the current 
session. 

Rename (Down Arrow Button) 

Opens the Rename dialog box to receive the new name for the session. Use this feature to 
change the name for the selected session. 

Run 

Connects to the remote host and run the specified command. 
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Close 

Closes Xstart. 

Help 

Opens Xmanager Help system. 

New Session dialog box 
The New Session dialog box allows you to enter a session name to create a new session. To 
open the dialog box, click New on the Xstart main window. 

 

Figure 39: Xstart New Session Dialog Box 

Enter a new session name 

Enter a new session name. A session name is used as a file name and you should avoid to use 
special characters (\/:*?"<>|) in the name. 

SSH Protocol Setup dialog box 
The SSH Protocol Setup dialog box allows you to configure a number of SSH options. You can 
open it by selecting SSH in the Protocol list of Xstart and then clicking Setup. 

The General tab 
In the General tab, you can configure SSH version, port and user authentication method. 
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Figure 40: Xstart SSH Protocol Setup Dialog Box, General Tab 

Preferred Version 

Select an SSH protocol you want to use. SSH2 is recommended since it provides better security 
and more functionalities than SSH1. 

Port Number 

Enter the port number for an SSH connection. 

Use Default 

Sets the Port Number value to 22. 

Send keep-alive signal 

Sends keep-alive messages to the remote host. It is useful when the connection is terminated 
unexpectedly on idle time. In some network environments, a gateway or a firewall system may 
terminate connections without notice when the connections are idle for a specified time period. 

Interval 

Enter the time interval that Xstart will send keep-alive messages. 
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The Options tab 
In the Options tab, you can configure security, performance and pseudo terminal options. 

 

Figure 41: Xstart SSH Protocol Setup Dialog Box, Options Tab 

Encryption 

Encryption algorithms are used to encrypt and decrypt network traffics. You can select a 
preferred encryption algorithm in the list. When you select the Cipher List, multiple algorithms 
are tried in order of appearance in the list. To edit the Cipher List, click Edit. 

MAC 

A MAC(Message Authentication Code) ensures data integrity and it provides increased security 
of SSH2 protocol over SSH1. You can select a preferred MAC algorithm in the list. When you 
select the MAC List, multiple algorithms are tried in order of appearance in the list. To edit the 
MAC List, click Edit. 

Compress network data 

Select this check box to compress all data traffic with the zlib algorithm. Compression will 
provide better performance in a slow network environment. 
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Allocate a pseudo terminal before executing the command 

Select this check box when you want to allocate a pseudo terminal on the remote host and 
then run a command on the pseudo terminal. A pseudo terminal is required for some X 
applications, and it ensures that shell environment variables are configured correctly as a 
normal logon. 

The Tunneling tab 
In Tunneling tab, you can set TCP/IP, Dynamic forwarding and X11 Forwarding rules. For 
these options to take effect, connection protocol must be set to SSH in Connection.  

 

Figure 42: Xstart SSH Protocol Setup Dialog Box, Tunneling Tab 

Add 

Opens the Forwarding Rule dialog box dialog box. It allows you to add a new TCP/IP forwarding 
rule for this session. Currently open sessions are not affected by the new forwarding rule. To 
apply it, close and open the session again.  

Edit 

Opens the Forwarding Rule dialog box dialog box and allows you to change the values of the 
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rule selected in the list. The modified values will apply the next time the session starts. 

Remove 

Removes the forwarding rule selected in the list. The changes are not applied to the currently 
open session. To apply it, close and open the session again.  

Forwarding Rule dialog box 
The Forwarding Rule dialog box allows you to add a new TCP/IP port-forwarding rule to a 
session. To open this dialog box, on Xstart, select SSH for Protocol and click on the Setup 
button. And then, in the session SSH Protocol Setup dialog box, click the Tunneling tab.  

 

Figure 43: Forwarding Rule 

Type (Direction) 

Select Local(Outgoing), Remote(Incoming), or Dynamic(SOCKS4/5) depending on the type of 
the connection. 

Most client programs such as POP3, telnet, and ftp are running on your local machine and try 
to connect to the remote server. So you need to select Local(Outgoing) for those client 
programs. 

For some server programs such as PC X server, and ftp server, the connection comes from the 
remote server (in which ssh server is running) to your local machine (in which Xmanager is 
running). You need to select Remote(Incoming) for this kind of connections. 
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Source Host 

When the host is assigned to multiple IP addresses, and you want to only allow a specific IP 
address to forward network traffic, you can use this option to specify the IP address to forward 
network packets here.  

 NOTES 

Usually the PC has multiple IP addresses when it is connected via VPN. 

Listen Port 

Enter or select the port to which the client program will try to connect. 

For Local(Outgoing) connections, the listen port is allocated by Xmanager in your local 
machine. When a client program in your local machine connects to the listen port, Xmanager 
forwards the connection to the ssh server over a secure tunnel and the ssh server again 
redirects the connection to the destination port of the destination host. 

For Remote(Incoming) connections, the listen port is allocated by the SSH server in the remote 
host. When a client program in the remote host connects to the listen port, the SSH server 
forwards the connection to xmanager over a secure tunnel and Xmanager again redirects the 
connection to the destination port of the destination host. 

Dynamic(SOCK4/5) forwarding works the same as Local forwarding. It uses the SOCKS 
protocol and its default port number is 1080. 

Accept local connections only 

Local, and Dynamic forwarding only accept connections from a PC where this session is 
currently running.  

 

Remote forwarding only accepts connections originated from the server where the session is 
connected to. 

Destination Host 

Enter the hostname or IP address of the host to which you want to forward connections. If you 
want to forward a POP3 connection, the destination host will be the host in which the mail 
server is running. For Incoming connections, it will be “localhost” in most cases. 

Destination Port 

Enter the port number of the destination host to which you want to forward connections. If you 
want to forward a POP3 connection, the destination port will be the port the mail server is 
listening (the default POP3 port is 110). Destination port is not needed for Dynamic port 
forwarding. 

Description 

Enter the description for the selected forwarding rule. 
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Password Setup dialog box 
The Password Setup dialog box allows you to enter the password for the selected session. To 
open the dialog box, click select Password for Authentication and click the Setup button. 

 

Figure 44: Password Setup Dialog Box 

Save my password 

To save the password for the session, select this option. Otherwise, the password is used for 
one time only. 

Password 

Enter the password for user authentication. 

Forget my password  

Removes the password for the selected session.  

Public Key Authentication Setup dialog box 
The Public Key Authentication Setup dialog box allows you to choose, create and view the 
user key for the selected session. You can also enter the passphrase for the selected user key. 
To open the dialog box, click select Public Key for Authentication and click the Setup button. 
This option is only available for SSH sessions. 
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Figure 45: Public Key Authentication Setup Dialog Box 

User Key 

Select the user key that will be used when the Public Key authentication is selected. If this box 
is left blank, a prompt dialog box asking for a user key will appear when required. If there is no 
user key in the list, you should create a new key and register it into the remote SSH server. 

Browse 

Opens the User Keys dialog box. You can import and export user keys in the User Keys dialog 
box.  

Generate 

Opens the User Key Generation Wizard. 

View public key 

Opens the Host Keys dialog box. 

Passphrase 

Enter the passphrase of the user key you selected. It is encrypted and saved in the session file. 
For better security, just leave it blank. 

Use SSH authentication agent (Xagent) 

Select this option to use Xagent for SSH public key authentication. Xagent is an SSH 
authentication agent. Xagent keeps a record of every user key in the Xshell user key database, 
and asks for the passphrase of a user key when it is required. When the passphrase of a user 
key is provided, Xagent decodes the user key and holds it in memory. 

TELNET/RLOGIN/RSH/REXEC Protocol Setup dialog box 
In the Protocol Setup dialog box, you can change the port number for the selected protocol 
and the time-out value to terminate a connection. You can open it by clicking Setup on the 
Xstart main window when the protocol is TELNET, RLOGIN, RSH or REXEC. 
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Figure 46: Xstart TELNET Protocol Setup Dialog Box 

Port Number 

Enter a port number for the selected protocol. Make sure that the remote server is listening the 
same port for the protocol. 

Use Default 

Sets a default port number for the selected protocol. The default port for each protocol is 
following: 

• TELNET:  23 

• REXEC:  512 

• RLOGIN:  513 

• RSH:  514 

Time-out 

Enter a time-out value to terminate the connection. This time-out value is used only for 
TELNET and RLOGIN protocols. 

After a successful logon, a TELNET or RLOGIN shell is allocated on the remote server, and 
Xstart executes a command on the shell prompt. Xstart disconnects from the server after the 
specified time-out and it also closes the login shell. If the time-out is 0, the connection is active 
while Xmanager is running. 

Be aware that the X application invoked from the shell may also be closed when the connection 
is closed prematurely. 

Registered Commands dialog box 
This dialog box adds a predefined command on the menu and allows you to enter a long 
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command into the Execution Command box with a single click on the menu. To open the 
dialog box, click the arrow button on the right of the Execution Command box, and then click 
Add/Remove. 

 

Figure 47: Xstart Registered Commands Dialog Box 

Add 

Opens the Add Command dialog box. You can add a new command in the dialog box. 

Remove 

Removes the selected command from the list. 

Add Command dialog box 
The dialog box creates a new command and adds it to the list on the Registered Commands 
dialog box. To open it, click Add on the Registered Commands dialog box. 

 

Figure 48: Xstart Add Command Dialog Box 

Name 

Enter a name that will appear as a label on the menu. 
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Command 

Enter a command that will be entered into the Execution Command box of Xstart. 

Xstart Advanced Options dialog box 
The Advanced Options dialog box allows you to configure Xmanager profile and prompt 
options. You can open it by clicking Advanced in Xstart. 

The X Server tab 
For the X Server tab, see the X Server tab of the Xbrowser Properties dialog box. 

 

 

Figure 49: Xstart Advanced Options Dialog Box, Prompt Tab 

The Prompt tab 
In the Prompt tab, you can specify login prompts and shell command prompts for a remote 
host. 
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Figure 50: Xstart Advanced Options Dialog Box, Prompt Tab 

When you click Run on Xstart, it tries to log on to a remote host followed by searching for a 
shell prompt to run a command. 

The logon step requires the user to enter a user name and a password. Most Unix systems are 
using “login:” and “Password:” to prompt the user to enter account information. Xstart allows 
you to specify the prompt strings for the hosts having different prompts. Logon prompts are 
used only for TELNET and RLOGIN protocols. 

After a successful logon step, Xstart tries to find a shell prompt such as “$” or “#”. If a shell 
prompt is found, it sends the command you entered in the Execution Command box. Shell 
prompt is used when TELNET or RLOGIN protocol is selected, also when SSH protocol is 
configured to run a shell. 

User Name Tokens 

Enter a string for a user name prompt. Once the string is received from the remote host, 
Xstart recognizes it as a user name prompt. You can specify multiple tokens by separating 
them with the bar (|) characters. 



 

Reference   |   107 

Password Tokens 

Enter a string for a password prompt. Once the string is received from the remote host, Xstart 
recognizes it as a password prompt. You can specify multiple tokens by separating them with 
the bar (|) characters. 

Wait till a token from the followings matches with the text stream 

Enter a string for a shell prompt. Once the string is received from the remote host, Xstart 
recognizes it as a shell prompt. If a shell prompt is found, Xstart sends a command to the 
remote host. You can specify multiple tokens by separating them with the bar (|) characters. 

Wait for the following standby-time interval 

Select this option when the shell prompt is not clear or interferes with other messages. Once 
this option is selected, Xstart does not try to find a shell prompt. Instead it sends the 
command immediately after the specified time interval. 

Command tag definition 
Xstart offers some command tags which allow you to automate a routine command sequence. 
The command tags are entered in the Execution Command box. 

Command tags are defined below: 

TAG Description 

<%CR%> Sends a carriage return character (\r). 

<%LF%> Sends a new line character (\n). 

<%SEND=”string”%> Sends a string. Xstart does not process DISPLAY and 
PCADDR variables in the string. 

<%WAIT=”string1|string2”%> Waits for the string1 or string2. 

<%SLEEP=n%> Sleeps for n seconds. 

<%POPUP=”string”%> Pops up the Reply Messages dialog box when the 
specified string is received. 

All tags are processed in sequence except for the POPUP tag which is valid till the command is 
completed entirely. 

 Notes 

Command tags are supported in TELNET and RLOGIN protocols. To use in the SSH 
protocol, select the Allocate a pseudo terminal before executing the command check 
box in the Options tab of the SSH Protocol Setup dialog box. 

Examples 

1. The command below is a multi-logon example. After Xstart logs on to a host 
successfully, it connects to another host using telnet, and then run an xterm: 
 
telnet host2<%CR%><%WAIT=”login:”%>root<%CR%> 
<%WAIT=”Password:”%>password<%CR%><%WAIT=”$”%>xterm 
 

2. The command below pops up the Reply Messages dialog box when a “assword:” 
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string is received. This is useful when your password is expired once a month and you 
should enter a new password before a command prompt appears: 
 
<%POPUP=”assword:”%>xterm –ls –display $DISPLAY 

Xrcmd command line options 
Xstart offers command line options for advanced users who want to integrate Xstart with 
their own applications. 

Actually Xstart provides only a user-interface for creating and managing sessions. When you 
run a command using Xstart, it invokes Xrcmd.exe and passes all session information to the 
program. Thus, you have to use Xrcmd.exe, not Xstart. You can find the Xrcmd program in 
the folder Xmanager is installed. 

The command line syntax of Xrcmd: 

Xrcmd –protocol ssh|telnet|rexec|rsh|rlogin|local –host hostname 

–user username [-password password] [-userkey keyname] 

[-passphrase userkeypass] [-shell] [-zlib] [-status] [-result] 

[-dispno nnn] [-timeout nnn] [-port nnn] 

-command command 

 Notes 

The –command option should be at the end of the Xrcmd command. 

Options: 

-protocol  protocol Specify the connection protocol. 

-host hostname  Specify the remote host. 

-user username  Specify the user account on the remote host. 

-password xxxx  Specify the password of the user account. If this option is not 

provided, a prompt dialog box appears on connection. 

-userkey keyname Specify the user key name. This option is useful only for SSH 

connections. 

-passphrase userkeypass Enter the passphrase of the user key. This option is useful 

   only for SSH connections. 

-shell   Runs the command after allocating a shell (pseudo terminal). 

   This option is useful only for SSH connections. 

-zlib   Compresses network data with the zlib algorithm. 

   This option is useful only for SSH connections. 

-status   Shows the status dialog box while connecting to the remote 

host. 

-result   Shows the Reply Messages dialog box. 

-dispno nnn  Specify the display number Xmanager will use. If this option 

   is not provided, Xmanager allocates an appropriate one. 

-timeout nnn  Closes the connection after nnn seconds. 
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-port nnn  Specify the connection port for the protocol. If this option is 

not provided, the default port of the protocol will be used. 

-command command Specify the remote command which will be executed on the 

   remote host. 

An example: 

Xrcmd –protocol telnet –host mylinux –user myname –status 

–command /usr/bin/X11/xterm –ls 

Xrcmd connects to mylinux with the TELNET protocol, logs on as myname, and then runs an 
xterm command on the remote host. A status dialog box opens while connecting to the host. 
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Xconfig 
Xconfig is a powerful tool for configuring and managing Xmanager profiles. A profile contains 
Xmanager options such as window mode, fonts, color, security, etc. You can create multiple 
profiles using Xconfig and specify a different profile for each session. 

When you run a session in Xbrowser or Xstart, the session brings up Xmanager with the 
profile seleted in the session. If you want to configure a different window mode for a session, 
you can create a new profile in Xconfig, change the window mode and select it in the session. 

Xconfig main window 
Xconfig main window consists of a menubar, a toolbar, a workspace and a status bar. 

 

 

Figure 51: Xconfig Main Window 

The workspace displays all available Xmanager profiles. You can select one of these profiles 
into an Xbrowser or Xstart session. 

A sharing profile has a hand on its icon and it can be modified only by a user who has an 
administrator’s privilege. A default XDMCP or Xstart profile is indicated by a small black dot on 
the icon. 
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File menu 
In the File menu, you can create and delete a profile and edit the properties of a selected 
profile. 

 

Figure 52: Xconfig File Menu 

Set as Default XDMCP Profile 

Sets the selected profile as a default XDMCP profile. A default XDMCP profile is applied to the 
dynamic sessions in Xbrowser. 

Set as Default Xstart Profile 

Sets the selected profile as a default Xstart profile. A default Xstart profile is applied to the 
sessions created by Xstart. 

Sharing 

Shares the profile with all users in the system. A sharing hand appears on the icon. Only the 
users who have an administrative privilege can use this command. A shared profile is stored in 
a system folder. 

Delete 

Deletes the selected profile from the list. When you delete a profile that is being used by a 
session, the session will use a default profile instead of the deleted one. 

Rename 

Changes the name of the selected profile. 

Properties 

Opens a Properties dialog box for the selected profile. 
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Send To->Mail Recipient 

Opens a mail composer with the profile attached to the message. It is useful when an 
administrator creates a template profile and wants to distribute it to other users. 

Exit 

Quits the Xconfig program. 

Edit menu 
In the Edit menu, you can copy, paste and select profiles. 

  

Figure 53: Xconfig Edit Menu 

New Profile 

Creates a new profile on the workspace. The new profile is copied from the default Xstart 
profile. 

Copy 

Copies the selected profile into memory. 

Paste 

Pastes the copied profile to the workspace. 

Select All 

Selects all profiles at once. 

View menu 
In the View menu, you can show or hide Toolbar and Status Bar, and change the listing style 
of the workspace. 
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Figure 54: Xconfig View Menu 

Toolbar 

Shows or hides the Toolbar. 

Status Bar 

Shows or hides the Status Bar. 

Large Icons 

Changes the listing style to the Large Icons view. 

Small Icons 

Changes the listing style to the Small Icons view. 

List 

Changes the listing style to the List view. 

Details 

Changes the listing style to the Details view. 

Refresh 

Reloads all profiles and refreshes the list. 

Help menu 
In the Help menu, you can open Xmanager Help system and get information about the 
current version. 

 

Figure 55: Xconfig Help Menu 

Contents and Index 

Opens Xmanager Help system. 

Online Support  

Opens an Internet browser and goes to the support page of Xmanager. 
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Check for Updates 

Checks the newest version of Xmanager to help with upgrading it. 

About Xconfig 

Opens an About dialog box which contains the version and license information. 

Toolbar buttons 
Xconfig provides a number of toolbar buttons for commonly used tasks and commands. You 
can also perform the same tasks from the menu bar. 

 

Figure 56: Xconfig Toolbar Buttons 

The list below describes the toolbar buttons. 

Button Name Description 

 
New Creates a new profile on the workspace. The new profile is copied 

from the default Xstart profile. 

 Delete Deletes the selected profile from the list. 

 Properties Opens a Properties dialog box for the selected profile. 

 Copy Copies the selected profile into memory. 

 Paste Pastes the copied profile to the workspace. 

 Refresh Reloads all profiles and refreshes the list. 

 Views Changes the listing style of the workspace. 

 Help Opens Xmanager Help system. 

Properties dialog box 
The Properties dialog box allows you to customize the settings of a profile. You can open it by 
clicking Properties on the File menu or the Properties button on the toolbar. 

In the dialog box, you can configure Xmanager options such as a window mode, fonts and 
other advanced options. 

The General tab 
In the General tab, you can set the window mode and default profiles for XDMCP and Xstart 
sessions. 



 

Reference   |   115 

  

Figure 57: Xconfig Properties Dialog Box, General Tab 

Choose Window Mode to use 

Select a window mode in the list. Xmanager supports three window modes: Auto detect, 
Single Window Mode and Multiple Window Mode. 

Auto detect selects an appropriate window mode depending on the session. It sets the window 
mode to Single Window Mode for XDMCP sessions and Multiple Window Mode for Xstart 
sessions. 

Single Window Mode opens an Xmanager main window for the entire remote desktop and all 
remote X applications open within the window. You can manage all remote applications with a 
single window on your Windows desktop. 

Multiple Window Mode opens each remote X application as a separate window on Windows 
desktop. So, each application looks like a Windows application. It is useful when you want to 
open just one or two remote applications, but not the entire remote desktop. 
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Settings 

Opens a Window Mode Settings dialog box. In the dialog box, you can configure several 
options for Single and Multiple window modes. 

Terminate at Reset 

Terminates Xmanager when all remote X applications are closed. If this options is not 
checked, Xmanager resets to the initial state and waits for X applications in the background. 

Set as default XDMCP profile 

Sets this profile as a default XDMCP profile. A default XDMCP profile is applied to the dynamic 
sessions in Xbrowser. 

Set as default Xstart profile 

Sets this profile as a default Xstart profile. A default Xstart profile is applied to the sessions 
created by Xstart. 

Default Display Number 

Sets the default display number for XDMCP and Xstart sessions. Sessions use the default 
display number if it is not explicitly defined in the session.  

Xstart Session 

Sets the default display number for Xstart sessions. 

XDMCP Session 

Sets the default display number for XDMCP sessions. 

The Font tab 
In the Font tab, you can add and remove font directories, font servers and configure a number 
of font options. 
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Figure 58: Xconfig Properties Dialog Box, Font Tab 

Font Catalogues 

Enumerate all font path elements. A font catalogue is a font directory which contains font files 
or a font server running on the remote Unix host. 

Xmanager reads all checked font path elements in order when it starts. The unchecked font 
path elements are not read by Xmanager. 

The Description column shows the name of the font path element. The Path column shows 
the actual path of the font directory or the exact definition for a font server. 

Move Up 

Moves the selected font path element to the top by one. 

Move Down 

Moves the selected font path element to the bottom by one. 
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Remove 

Removes the selected font path element from the list. This just removes the element from the 
list and does not delete the installed font files from the file system. 

It is recommended that you avoid removing the default font path elements provided by 
Xmanager unless you are an expert. 

Add Font Directory 

Opens an Open dialog box. You can locate a "fonts.dir" file to add the directory to the font list. 

Add Font Server 

Opens an Add Font Server dialog box. You can specify a font server in the dialog box. 

Default Font 

Enter the name of the default font. A default font must be provided and it is used when an X 
application does not specify a font to display. 

Shows Missing Font Dialog 

If you select this option, Xmanager displays a dialog box when it cannot find the font 
requested by the remote X application. This is useful when you want to know which font is 
required for the application. 

Automatic Font Substitution 

When the font which an X application request is not found, Xmanager substitutes another font 
for the requested one. 

Permit Font Path Change 

This option allows a remote X application to change the font catalogue while Xmanager is 
running. 

The Color tab 
In the Color tab, you can configure a default visual, color database and other color options. 
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Figure 59: Xconfig Properties Dialog Box, Color Tab 

Choose Default Visual 

Select a default visual which the root window of Xmanager will use. 

A visual is a device-independent color system and it defines the color format and the number 
of colors supported by Xmanager. Xmanager supports the 6 standard visuals defined in the 
X Window standard: PseudoColor, StaticColor, DirectColor, TrueColor, GrayScale and 
StaticGray. 

If the Default Visual is set to Auto Detect, Xmanager will find and set up a proper default 
visual for the video device. In the 256 (8 bits) colors video mode in Windows, Xmanager will 
set it to PseudoColor. And in the true-color (16 bits and above) video device, Xmanager will 
set it to TrueColor. 

Most X applications works well in any type of visual. However, some old CAD programs can run 
only in the PseudoColor visual and you should set the default visual to that one to run it 
successfully. 
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Automatic Color Substitution for PseudoColor 

Substitutes a requested color for a similar one in PseudoColor. 

In PseudoColor visual, there are only 256 colors for all X applications and sometimes an 
application may fail to run due to a lack of color cells. This option allows the application to work 
well even when all the color cells are already allocated to other applications. 

Preserve System Colors (20 Colors) 

Preserves 20 system colors for Windows applications in PseudoColor visual.  

In a 256 colors video mode, MS Windows uses 20 system colors for title bar, window border, 
icons and so on. Some X applications may use the entire palette of 256 colors in order to have 
a correct color display. In this situation, the colors of the Windows background and icons will 
flash. You can prevent this by selecting this option. 

Exact StoreColor for PseudoColor 

Processes the StoreColor request exactly as defined in an X protocol standard. 

When Windows is in a true-color video mode, the StoreColor request for a PseudoColor visual 
may affect the overall performance of Xmanager. 

Reverse RGB Order for TrueColor 

Sets the Red, Green, and Blue value of a color pixel in reverse order. 

By default, the Blue bits are the least significant bits in the TrueColor visual. If you select this 
option, the Red bits becomes the least significant bits. It is useful when an X application 
requires a specific format for the RGB bits. 

Filename 

Shows the color database file. A color database maps red, green, and blue values to a readable 
color name. 

Change 

Opens an Open dialog box to locate a color database. 

View 

Opens the color database with a notepad. 

The Devices tab 
In the Devices tab, you can configure the settings of keyboard, mouse, sound, and monitors. 
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Figure 60: Xconfig Properties Dialog Box, Devices Tab 

Keyboard Settings 

Opens a Keyboard Settings dialog box. In the dialog box, you can configure keyboard types, a 
hot key to switch the keyboard type, and other keyboard options. 

Mouse Settings 

Opens a Mouse Settings dialog box. In the dialog box, you can configure a 3-button emulation 
and other mouse options. 

Sound Settings 

Opens a Sound Settings dialog box. In the dialog box, you can select a bell type and specify a 
sound file. 

Monitor Settings 

Opens a Monitor Settings dialog box. In the dialog box, you can select a monitor to be used in 
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a multi-monitor system. 

The Security tab 
In the Security tab, you can configure the host-based access control for security. 

 

Figure 61: Xconfig Properties Dialog Box, Security Tab 

Enable Access Control 

Turns on the host-based access control which allows connections from the trusted hosts. 

When access control is turned on, only the X applications on the trusted hosts can connect to 
Xmanager. If it is disabled, all X applications can connect to Xmanager. 

Trusted Hosts 

Shows the hosts you can trust. If a remote Unix host is added to the list, all users on the host 
can run an X application and connect to Xmanager. 
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Add 

Adds an host to the trusted list. 

Remove 

Removes the selected host from the list. 

Warn Unauthorized Connections 

Shows a warning dialog box when an unauthorized X application tries to connect to 
Xmanager. You can accept or reject the connection. 

The Advanced tab 
In the Advanced tab, you can configure X extensions and other advanced options. 

  

Figure 62: Xconfig Properties Dialog Box, Advanced Tab 
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Automatic Cut & Paste 

When this option is turned on, Xmanager copies and pastes text between X and Windows 
applications automatically. If you copy a text from an X application, you can paste it in any 
Windows application and vice versa. 

X Selection 

Need to update 

Cut Buffer 

Need to update 

Cut & Paste on Focus Change 

Need to update 

Display Change Message 

Displays a warning dialog box when Windows changes its video mode such as screen size or 
color mode. When the screen size or color mode is changed, Xmanager should restart. 

Maximize Performance 

This option makes Xmanager run with its maximum performance. Xmanager selects the 
fastest method to do complex drawing operations. 

It may cause some graphic images to be displayed poorly depending on your video device or 
application. 

Permit old bugs 

Select this option if the version of a remote X application is older than X11R6 and it is not 
running properly with Xmanager. 

Accept Esound Request 

Select this option to play the remote Esound requests. Esound uses TCP port 16001. 

Verbose Log Message 

Select this option to save more detailed log message. NetSarang technician may ask you to 
enable this option when you are submitting the log for a review. 

Backing Store 

Select an appropriate backing store mode. 

A backing store is a memory area in which Xmanager saves the obscured part of a window. If 
a window is hidden by another window, the obscured area should be redrawn after it has been 
exposed again. By saving the obscured area in memory, Xmanager can recover the area 
faster than the application draws it once again. It also saves data traffics in a slow network 
line. 

Xmanager provides four backing store modes: Do Not Use, When Requested, When Mapped, 
and Always. 

Do Not Use turns off the backing store feature and X applications should always redraw the 
obscured area. 

When Requested does not use the backing store feature too. However if an X application 
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requests the backing store feature for its windows, Xmanager enables the backing store for 
only those windows. 

When Mapped enables the backing store feature for all windows by default. All windows except 
for the unmapped or iconized one will benefit the backing store feature. 

Always enables the backing store feature for all windows including mapped, unmapped and 
iconized windows. It requires a lot of system memory and graphic resources. 

Extensions 

Select the X extensions you want to use. 

Xmanager supports BIG-REQUEST, DAMAGE, DEC-XTRAP, DOUBLE-BUFFER, Extended-Visual-
Information, MIT-SUNDRY-NONSTANDARD, Multi Buffering, RECORD, RENDER, SECURITY, 
SHAPE, SYNC, TOG-CUP, XC-APPGROUP, XC-MISC, XEVIE, XFIXES, XInput, XKEYBOARD, and 
XTEST extensions. Especially Render extension gives you advanced graphic environment for X 
applications. Also GLX(OpenGL) extension is included in Xmanager Enterprise edition. 

X Resource Database 

Shows the path of X resource database which will be processed when Xmanager starts. 

Change 

Opens an Open dialog box to change the resource database. 

View 

Opens the resource database with a notepad. 

Window Mode Settings dialog box 
In the Window Mode Settings dialog box, you can customize options for single and multiple 
window modes. You can open the dialog box by clicking Settings on the General tab of the 
Properties dialog box. 

The Single Window Mode tab 
The Single Window Mode tab allows you to choose the main window size and configure a scroll 
bar option. 
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Figure 63: Window Mode Settings Dialog Box, Single Window Mode Tab 

Window Size 

Select the size of the Xmanager main window. The window size will be the size of the X root 
window. 

Desktop Size opens Xmanager main window as large as the desktop excluding the task bar. 

Full Screen opens Xmanager main window to occupy the entire screen, and it has no title bar 
and sizing border. It will also hide the Windows task bar. 

Use Scrollbar 

Attaches scroll bars on the right and bottom of the Xmanager main window. It is useful when 
you want to make Xmanager window size larger than the Windows desktop size. 

The Multiple Window Mode tab 
The Multiple Window Mode tab allows you to customize the background policy, window 
manager and other useful options. 
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Figure 64: Window Mode Settings Dialog Box, Multiple Window Mode Tab 

Background 

Select one of the three desktop background modes: MS Windows Background, X Window 
Background, or X Window Background (Transparent). 

MS Windows Background gives the control over the desktop background to MS Windows. You 
cannot use the X root window background in this mode. 

X Window Background gives the control over the desktop background to Xmanager. The 
background will be changed to X root window and the mouse pointer will also be changed to X 
pointer. In this mode, you cannot use the Windows icons on the desktop background. 

X Window Background (Transparent) works the same way as the X Window Background 
mode. However, the desktop background looks like the Windows desktop. You can still see the 
Windows icons on the desktop, but those icons are not active. 

 Notes 

The Background option will be applied only when a remote window manager is running. 

Window Manager 

Select the window manager which will manage each X application window. Xmanager 
supports Automatic Switch, Remote Only, and Local Only for the window manager style. 

A window manager is a program that manages X application windows. It attaches a title bar, 
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border and system menu to a window. And also it can resize, move, iconize and close the 
window. A local window manager is the one which looks the same as MS Windows, and it 
attaches the same title bar and border as Windows applications to X application windows. A 
remote window manager such as dtwm, mwm, fvwm is running on a remote host and it 
looks different than the local window manager. 

Automatic Switch mode switchs the window manager automatically and you do not have to pay 
attention to the window manager. At the beginning, Xmanager runs a local window manager, 
and when a remote window manager tries to connect to Xmanager, the local window 
manager is automatically closed. And if the remote window manager is closed by user, the local 
window manager will run again. 

Remote Only mode do not run a local window manager. You should always run a remote 
window manager to manage X application windows. 

Local Only mode do not allow the connection of a remote window manager. All X application 
windows will be managed as the same way as Windows applications. 

Use System Tray at Startup 

Enters the Xmanager icon in the system tray. 

Include Taskbar in X Root Window 

Includes the Taskbar area in the X root window. It may cause the bottom area of the remote 
desktop to be obscured by Taskbar. 

Use Panning 

Enables the panning feature for all X application windows when a local window manager is 
active. 

This feature is very useful when the window size is too large to fit in the desktop or part of the 
window is in the outside of the desktop. By moving the mouse pointer to the edge of the 
desktop, the window will be automatically moved into the inside of the desktop. 

Panning Settings 

Opens a Panning Settings dialog box which allows you to adjust panning speed and anchor 
positions. 

Auto Raise Window 

Raises a window to the top and switches the input focus to the window when the mouse 
pointer enters the window. 

Interval 

Enter an interval as a milli-seconds unit. It gives a delay before the window is being raised to 
the top. 

Panning Settings dialog box 
The Panning Settings dialog box allows you to adjust panning speed and positions. You can 
open it by clicking Panning Settings on the Multiple Window Mode tab of the Window 
Mode Settings dialog box. 
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Figure 65: Panning Settings Dialog Box 

Velocity 

Enter the panning speed in pixels. Every time the mouse pointer touches a panning position, 
the panning window slides into the desktop by the pixels you specified. 

Left 

Enter the anchor position relative to the left of the desktop. The unit is pixels. When the mouse 
pointer moves into the anchor position, the window starts to slide. 

Right 

Enter the anchor position relative to the right of the desktop. The unit is pixels. When the 
mouse pointer moves into the anchor position, the window starts to slide. 

Top 

Enter the anchor position relative to the top of the desktop. The unit is pixels. When the mouse 
pointer moves into the anchor position, the window starts to slide. 

Bottom 

Enter the anchor position relative to the bottom of the desktop. The unit is pixels. When the 
mouse pointer moves into the anchor position, the window starts to slide. 

Add Font Server dialog box 
The Add Font Server dialog box allows you to add a font server catalogue to the font 
catalogues list. You can open it by clicking Add Font Server on the Font tab of the Properties 
dialog box. 
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Figure 66: Add Font Server Dialog Box 

Hostname 

Enter the host in which the font server is running. 

Port 

Enter the port number on which the font server listens. The default port number is 7100. 

Keyboard Settings dialog box 
The Keyboard Settings dialog box allows you to select keyboard types, specify a hot key to 
switch keyboards and other keyboard options. You can open it by clicking Keyboard Settings 
on the Devices tab of the Properties dialog box. 
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Figure 67: Keyboard Settings Dialog Box 

Xmanager supports many international keyboards. You can find a proper keyboard file that 
maps your keyboard layout correctly and add it to the Keyboard List for Xmanager.  

Keyboard List 

Shows the keyboard files you want to use with Xmanager. The keyboard files on the list 
appears on the Keyboard Selection dialog box and you can change your keyboard type at 
any time while using Xmanager. 

Add 

Opens an Add Keyboard dialog box to add a keyboard file to the list. You can select an 
appropriate keyboard file in the dialog box. 

Remove 

Removes the selected keyboard file from the list. 

Edit 

Opens Keyboard Editor which allows you to edit the key-mappings of the selected keyboard 
file. 

Import 

Opens an Open dialog box to import a keyboard file. 

Export 

Opens a Browse for Folder dialog box to export a keyboard file. 

Set Default 

Sets the selected keyboard file as the default keyboard file. Xmanager opens the default 
keyboard file when it starts. 

Hot Keys for switching the keyboard 

Select a hot key which will open the Keyboard Selection dialog box while Xmanager is 
running. Using the hot key, you can switch your keyboard type at any time. 

Permit Modification of Keymap 

Allows X applications to modify key-mappings. It is recommended that only advanced users 
select this option. 

Use [Left Alt+F4] for Closing Window 

Select this option if you want to close X application windows using the [Left Alt + F4] key 
sequence as you do it for Windows applications. When the X application is using the key 
sequence for other purposes, clear the check box. 

Use [Right Alt+F4] for Closing Window 

Select this option if you want to close X application windows using the [Right Alt + F4] key 
sequence as you do it for Windows applications. When the X application is using the key 
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sequence for other purposes, clear the check box. 

Add Keyboard dialog box 
The Add Keyboard dialog box shows all the keyboard files available for international 
keyboards and allows you to select an appropriate one. You can open it by clicking Add on the 
Keyboard Settings dialog box. 

 

Figure 68: Add Keyboard Dialog Box 

The Description column shows a meaningful name of a keyboard file. The Name column 
shows the actual file name of the keyboard file. 

Mouse Settings dialog box 
In the Mouse Settings dialog box, you can configure 3-button emulation, wheel mouse and 
cursor color. You can open the dialog box by clicking Mouse Settings on the Devices tab of 
the Properties dialog box. 
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Figure 69: Mouse Settings Dialog Box 

Click the left and right buttons simultaneously 

Select this check box to enable 3-button emulation for a 2-button mouse. You can emulate the 
middle button by pressing the left and right buttons simultaneously. 

Click Speed 

Adjust the time interval between the left and right buttons. The click speed represents the 
waiting time of one button after the other button has been pressed. During the waiting time, 
the button that has been pressed will wait for the other button to be pressed as well. 

 Notes 

If the click speed is set too fast, the middle button may not work no matter how fast you 
press the two buttons simultaneously. 

Use Right Button as Middle Button 

Select this check box when you are using the middle button very often and the right button is 
not useful. 

Use Mouse Wheel 

Select the check box to generate mouse events when you rotate the wheel. A button4 event is 
generated when you rotate the wheel forward, away from you; a button5 event is generated 
when you roate the wheel backward, toward you. 

 Notes 

When this option is enabled, some CDE applications cannot open a menu with the right 
button. 
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Use Color Mouse Pointer 

Select this check box to display color mouse pointers. When you clear it, all mouse pointers are 
displayed as black and white colors. 

Sound Settings dialog box 
In the Sound Settings dialog box, you can select a bell type and specify a sound file. You can 
open the dialog box by clicking Sound Settings on the Devices tab of the Properties dialog 
box. 

 

Figure 70: Sound Settings Dialog Box 

Bell Type 

Select an appropriate audio device for the bell request of X applications. You can select one of 
three bell types: Sound Card, PC Speaker and None. 

If you select a Sound Card, you need to specify an appropriate sound file (.wav) in the Sound 
File box. If you select None, the bell is disabled. 

Sound File 

Shows the sound file (.wav) you selected for the bell request of X applications. 

Browse 

Opens an Open dialog box to select a sound file. 

Monitor Settings dialog box 
In the Monitor Settings dialog box, you can choose a monitor to display X application 
windows in a multi-monitor system. You can open the dialog box by clicking Monitor Settings 
on the Devices tab of the Properties dialog box. 
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Figure 71: Monitor Settings Dialog Box 

Monitor to be used 

Select an appropriate monitor to display X application windows. The list shows all available 
monitors including Auto detect and Virtual Screen. 

When you select a monitor, Xmanager uses only the monitor to open and display X application 
windows. Virtual Screen is a virtual rectangular area which includes all monitors. 

When you select Auto detect from the list, Xmanager uses Virtual Screen for multiple window 
mode and the primary monitor for single window mode. 

Show the Monitor Selector at startup 

Select this check box to open a Monitor Selector dialog box when Xmanager starts. 
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Keyboard Editor 
Keyboard Editor helps you create and edit keymap files for international keyboards. It is 
designed to support various international keyboard layouts such as US 101-key, UK 102-key, 
Korean 103-key, Japanese 106-key and Brazilian ABNT2. 

It supports the compose sequence for European keyboards and a latch feature to emulate 
locked keys. For multi-user environments, it supports a sharing feature for the keymap files 
you created. 

Xmanager supports a lot of predefined keymap files for most international keyboards and 
languages. Thus, you may find an appropriate keymap file which is suitable for your 
applications. Even though you cannot find a proper one, you can select a similar keymap file 
which can minimize your editing effort. 

Keyboard Editor main window 
You can open Keyboard Editor by clicking Edit in the Keyboard Settings dialog box. 
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Figure 72: Keyboard Editor Main Window 

The main window shows a keyboard layout graphically and mappings for each key as a list. 
Keyboard Editor supports two layout modes: Normal Layout and Compose Layout. If you click 
the Keyboard Edit Mode button on the toolbar, the layout is toggled. 

Normal Layout shows basic keys on the keyboard and you can edit the keysyms for each key. A 
keysym is a symbolic name assigned to a key. 

Compose Layout shows the compose keys as highlighted and you can edit compose sequences 
for dead keys in European keyboards. 

File menu 
In the Files menu, you can create, open and save a keymap file. 

 

Figure 73: Keyboard Editor File Menu 

New 

Opens a Select Keyboard Type dialog box. After selecting a proper keyboard type, you can edit 
each key on the keyboard. 

Open 

Opens an Keyboard File Open dialog box. You can select an existing keymap file from the 
dialog box. 

Save 

Saves the changed keymap information as a file. If the Shared By All Users check box is 
selected from the toolbar, the keymap file is saved in a shared folder. 

Save As 

Opens a Save dialog box. You can saves the keymap file as another name in the dialog box. 

Import 

Opens Open dialog box. You can move an existing keymap file to Xmanager keymap folder. 

Exit 

Closes the Keyboard Editor window. 



 

138   |   Reference 

Edit menu 
In the Edit menu, you can edit normal keys, edit compose keys and create user defined 
keysyms. 

 

Figure 74: Keyboard Editor Edit Menu 

Edit Key 

Opens an Edit Key dialog box for the selected key. You can define keysyms and modifier state 
of the key. This command is available when the keyboard edit mode is Normal Layout. 

Add Compose Key 

Opens an Edit Compose Sequence dialog box to add a new compose sequence. You should 
select both key1 and key2 to generate a new compose key sequence. 

Edit Compose Key 

Opens an Edit Compose Sequence dialog box for the selected compose key. The key1 is 
selected automatically and you need to select a key2 for a new compose sequence. 

Remove Compose Key 

Removes the selected compose sequence from the list. 

User-defined Keysym 

Opens a User-defined Keysym dialog box. You can define a new keysym in the dialog box. 

View menu 
In the View menu, you can show or hide toolbars and change the keyboard edit mode. 

 

Figure 75: Keyboard Editor View Menu 
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Toolbar 

Shows or hides Toolbar. 

Status Bar 

Shows or hides Status Bar. 

Normal Layout 

Toggles the keyboard edit mode to the Normal Layout. 

Compose Layout 

Toggles the keyboard edit mode to the Compose Layout. 

Help menu 
In the Help menu, you can open Xmanager Help system and get information about the 
current version. 

 

Figure 76: Keyboard Editor Help Menu 

Contents and Index 

Opens Xmanager Help system. 

Online Support 

Opens an Internet browser and goes to the support page of Xmanager. 

About Keyboard Editor 

Opens an About dialog box which contains the version and license information. 

Toolbar buttons 
Keyboard Editor provides a number of toolbar buttons for commonly used tasks and 
commands. You can also perform the same tasks from the Menu bar. 

 

Figure 77: Keyboard Editor Toolbar Buttons 

The list below describes the toolbar buttons. 

Button Name Description 
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New Opens a Select Keyboard Type dialog box. After selecting a proper 

keyboard type, you can edit each key on the keyboard. 

 
Open Opens an Open dialog box. You can select an existing keymap file 

from the dialog box. 

 
Save Saves the changed keymap information as a file. If the Shared By All 

Users check box is selected from the toolbar, the keymap file is saved 
in a shared folder. 

 Edit Mode Toggles the keyboard edit mode to the Normal or Compose Layout. 

 Help Opens Xmanager Help system. 

Option bar 
From the Option Bar, you can select a sharing option and edit the description of the keymap 
file. 

 

Figure 78: Keyboard Editor Option Bar 

Shared By All User 

Select this check box if you want to share the keymap file with other users. A shared keymap 
file is indicated by a hand image on the icon and saved in the common user folder. 

Description 

Enter a description for the keymap file. 

Normal layout 
In the Normal layout, you can edit the modifier state and keysyms of each key. You can select 
the normal layout by clicking Normal Layout in the View menu. 
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Figure 79: Keyboard Editor Edit Mode, Normal Layout 

Each key on the keyboard has a name, keycode, scancode, keysym and modifier state. The 
name, keycode and scancode are predefined in Xmanager, and those values cannot be 
changed by the user. You can edit only the modifier state and keysym values. 

A scancode is a hardwired code generated from a key and it is defined by the keyboard 
manufacturer. 

A keycode is a unique number assigned to a key. It should be in the range between 8 and 255 
by the X Window protocol standard. 

A keysym is a symbol which grants a meaning to a key. Each key may have four keysyms 
depending on the state of the Shift and ModeSwitch keys: Normal, Shift, ModeSwitch and Shift 
ModeSwitch. A Normal keysym is used when you press only a key. A Shift keysym is used 
when you press a key while pressing a Shift key. A ModeSwitch keysym is used when you press 
a key while pressing a ModeSwitch key, usually the Alt_Right key. A Shift ModeSwitch keysym 
is used when you press a key while pressing both Shift and ModeSwitch keys. 

When you press the “A” key, Xmanager receives a scancode “0x1E” from the keyboard. The 
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keycode and keysym values for the key are defined as “0x51” and “0x61” for the US-101 
keymap file. Thus, Xmanager sends the keycode value “0x51” to the remote X application. 
The remote X application maps the keycode “0x51” to “0x61” as defined in the keymap file. 
The keysym “0x61” is defined as “A” in the X Window protocol standard, so the application 
knows which key was pressed. 

Compose layout 
In the compose layout, you can add, edit and remove compose sequences for dead keys in 
European keyboards. You can select the compose layout by clicking Compose Layout in the 
View menu. 

 

Figure 80: Keyboard Editor Edit Mode, Compose Layout 

A compose sequence is defined by two keys: key1 and key2. When you press key1 and key2 in 
sequnce, only a single keycode is generated and sent to the remote X application. 

For example, in order to enter the Atilde key “ã” from the French keyboard, you should press 
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“2” and “Q” keys in sequence. So, the keycode “132” is sent to the remote X application and it 
is known to the application as the Atilde key. 

In the layout, all keys defined as key1 are displayed in yellow color. If you click a key1 key, all 
corresponding key2 keys are displayed as bold text on the cap. 

By double-clicking a key1 or key2 key, you can edit its compose sequence. To add a new 
compose sequence, right-click on a key which will be used as key1 or key2. 

When a modifier is defined for a compose sequence, you should enter the modifier, key1 and 
key2 keys in sequence to generate the corresponding keycode. 

Select Keyboard Type dialog box 
The Select Keyboard Type dialog box helps you select one of seven international keyboard 
types. A new keymap file is created with the keyboard type you selected in the dialog box. You 
can open it by clicking New in the File menu. 

 

Figure 81: Select Keyboard Type Dialog Box 

Keyboard Type 

The Keyboard Type list shows all international keyboard types available in Xmanager. Each 
type has a different keyboard layout and the number of keys. Therefore you should select a 
similar keyboard type with your keyboard. 

User-defined Keysym dialog box 
The User-defined Keysym dialog box allows you to add or remove additional keysyms which 
are not defined in Xmanager. You can open it by clicking User-defined Keysym in the Edit 
menu. 
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Figure 82: User-defined Keysym Dialog Box 

Name 

Enter the keysym name which will be added in the list. 

Value 

Enter the keysym value as a hexdecimal format. 

Add 

Adds the keysym you entered in the Name and Value box to the list. 

Remove 

Removes the selected keysym from the list. 

Close 

Closes the dialog box. 

Edit Key dialog box 
The Edit Key dialog box helps you assign a keysym to a key and adjust other key 
characteristics such as repeat, latch and lock. You can open the dialog box by double-clicking a 
key on the Keyboard Editor window. 
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Figure 83: Edit Key Dialog Box 

The dialog box consists of three areas: Key, State and Keysym. Each area is descibed in detail 
below. 

Key 

Shows the scancode, key name and keycode of the selected key. 

State 

You can set a lot of key characteristics such as repeat, latch, lock and modifier in this area. 

Repeat is the function that generates the same key events repeatedly while you keep hold the 
key down. This function is turned on by default for most keys except for modifier keys such as 
Shift, Alt and Control. 

Latch is the function that generates only one of the KeyPress and KeyRelease event when a key 
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is pressed and then released. So, you should press and release the key twice to generate both 
KeyPress and KeyRelease events. Usually this feature is used for CapsLock or NumLock keys. 

Shift defines the key as a Shift key. 

CapsLock defines the key as a CapsLock key. 

Control defines the key as a Control key. 

Mod1 ~ Mod5 defines the key as a modifier key such as Alt and ModeSwitch. Usually the Alt 
key is defined as a Mod1 modifier. In some cases, the NumLock key is defined as a Mod3 
modifier. 

Keysym 

The Keysym area helps you assign Normal, Shift, ModeSwith and Shift ModeSwitch keysyms 
for the selected key. 

A keysym is a symbolic name that stands for a specific character and the name is mapped to a 
corresponding 32-bit value. For example, the “A” character is defined as “XK_A” and its value is 
“0x41”. 

To assign keysyms to a key, you should find an appropriate keysym from the search list in the 
dialog box. In the list, the preceding “XK_” string is omitted for convenience. You can find a 
keysym by name or by value. To find by name, enter the keysym name in the Keysym to find 
box. To find by value, enter the keysym value in the Value box and click Search. Once you 
find an appropriate keysym, it is highlighted in the list and you can set it as the keysym of the 
key. 

If you want to define the Normal keysym, find an appropriate keysym from the keysym list, 
highlight the keysym in the list and then click the arrow button on the Normal box. 

You can define four different keysyms for a key. 

Normal is used when you press the key without pressing any other modifiers. 

Shift is used when you press the key while pressing a Shift key. 

ModeSwitch is used when you press the key while pressing a ModeSwitch key. 

Shift M/S is used when you press the key while pressing both Shift and ModeSwitch keys. 

Edit Compose Sequence dialog box 
The Edit Compose Sequence dialog box helps you assign a keysym to a compose sequence 
and adjust other key characteristics such as repeat, latch and lock. You can open it by clicking 
Add Compose Key in the Edit menu after clicking Compose Sequence List tab. 
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Figure 84: Edit Compose Sequence Dialog Box 

The Edit Compose Sequence dialog box is nearly the same with the Edit Key dialog box 
except for the Compose Sequence area. This section explains only the Compose Sequence 
area. For more information about State and Keysym areas, see the Edit Key dialog box. 

Compose Sequence 

A compose sequence is defined by two successive keys and an optional modifier key. 

To define a compose sequence, click Key1 and then press a key which is used for the first key 
of the sequence. The scancode of the pressed key will be entered in the box. Then click Key2 
and press the second key. To assign a modifier to the sequence, click the arrow button on the 
Modifier box, and then select a proper modifier from the menu. 
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Common dialog box 
This section desribes common dialog boxes shared with other programs such as Xshell and 
Xftp. 

Host Keys dialog box 
The Host Keys dialog box allows you to manage the host keys collected from remote hosts. 
You can open it by clicking SSH Host Key Manager on the Tools menu of Xbrowser. 

 

Figure 85: Host Keys Dialog Box 

A host key is the public key of a remote host, and you can check the fingerprint on the key to 
verify the validity of the host. The remote host sends its public key to Xstart when the 
connection is established. When the host key is valid and you trust it, you can save the host 
key to the local database. If the host key is not saved in the database, the SSH Security 
Warning dialog box will appear when you try to connect to the host. 

Be sure that the fingerprint on the host key is exactly the same as the one on the host which 
you want to connect. 

Import 

Opens the Open dialog box to import a host key. An imported key will be saved into the 
database and listed in the Host Keys dialog box. 

Export 

Opens the Save dialog box to export the selected host key. An exported key will be saved as a 
file, and you can use it with other programs. The exported file is formatted as SECSH Public 
Key Format. 
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Remove 

Removes the selected host key from the database. 

View 

Opens a Notepad window with the contents of the selected host key. 

User Keys dialog box 
The User Keys dialog box allows you to create and manage user keys. You can open it by 
clicking SSH User Key Manager on the Tools menu of Xbrowser. 

 

Figure 86: User Keys Dialog Box 

A user key is comprised of two keys, a public key and a private key. The public key is 
registered to the remote server, and the private key is saved locally for Xmanager. When the 
public key authentication is in progress, the public key is sent to the server. If it is found on the 
server, the connection will be allowed. 

You can create a user key with the User Key Generation Wizard provided by Xmanager or 
the key generation tool on the remote host. When the user key is created on the remote host, 
you should get the private key from the host and import it on the User Keys dialog box . 
When the user key is created on Xmanager, you should register the public key to the remote 
host. Transferring a private key over the network is not recommended and it is more secure to 
create it on Xmanager and register the public key to the remote host. 

Import 

Opens the Open dialog box and saves the selected user key file in the user key database. 

Export 

Opens the Save dialog box and saves the selected user key as a file. The private key file is 
saved in NetSarang User Key format and it cannot be used with the programs provided by 
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other vendors. 

Delete 

Deletes the selected user key from the database. 

Rename 

Changes the name of the selected user key. 

Properties 

Shows the properties information of the selected user key. You can see the type, length, 
fingerprint, and public key of the selected key. Also you can change the passphrase of the key. 

Generate 

Opens the User Key Generation Wizard. 

User Key Properties dialog box 
The User Key Properties dialog box shows you the properties information of the selected 
user key. It also allows you to change the passphrase of the key and save the public key as a 
file. You can open the dialog box by opening the User Keys dialog box, selecting a user key, 
and then clicking Properties. 

General tab 
The General tab shows the type, length, and fingerprint of the user key. You can change the 
name and passphrase of the key. 
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Figure 87: User Key Properties Dialog Box, General Tab 

Key Name 

Displays the name of the user key. You can change the name when necessary. The name 
should have just the valid characters for being a filename. 

Change Passphrase 

Click this button to change the passphrase of the user key. 

Public Key tab 
The Public Key tab shows the public key part of the user key. You can save the public key as a 
file with the format you have selected. 
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Figure 88: User Key Properties Dialog Box, Public Key Tab 

View public key format as 

Select a public key format in the list. Currently supported formats are SSH2-OpenSSH, SSH2-
IETF SECSH, and SSH1. 

Save as a file 

Opens the Save As dialog box. You can save the public key in a file and register it to the SSH 
server. 

User Key Generation Wizard 
The User Key Generation Wizard dialog box allows you to create DSA or RSA user keys step 
by step. You can open it by clicking SSH User Key Generation Wizard on the Tools menu of 
Xbrowser. 

Step 1: Key Generation Parameters 
This step allows you to select the type and length of the user key. 
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Figure 89: User Key Generation Wizard 

Key Type 

Select DSA or RSA in the list. SSH1 protocol supports only RSA keys and SSH2 protocol 
supports both RSA and DSA. You should select the one that is supported by the remote server. 

Key Length 

Select a key length in the list. Longer keys provide better security while shorter keys provide 
better performance. The optimal key length for most applications is 1024 bits. 

Step 2: Public Key Pair Generation 
This step generates a user key with the parameters selected in the previous step. 
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Figure 90: Public Key Generation 

After the key has been generated successfully, you can click the Next button. 

Step 3: User Key Information 
This step allows you to enter the name and passphrase of the user key. 
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Figure 91: User Key Information 

Key Name 

Enter the name of the user key generated. The user key is saved as the name entered here 
and the name must have only valid characters for being a filename. 

Passphrase 

Enter the passphrase of the user key. It is used every time when you open it and you must 
remember it. 

Confirmation 

Enter the same passphrase again to confirm it. 

Step 4: Public Key Registration 
This step allows you to register the public key part of the user key to a remote server. You can 
also register it later from the User Keys dialog box. The private key is stored in the user key 
database on local machine. 
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Figure 92: Public Key Registration 

Public Key Format 

Select one of the formats (SSH1, SSH2-OpenSSH, and SSH2-IETF SECSH) in the list. The text 
box below will show you the public key in the selected format. You can copy the text and store 
it as a file on the remote server. Depending on the server, steps needed to register the public 
key are different. In most cases, the following guideline will work for each format. 

• SSH1: Copy the text and save it to $HOME/.ssh/authorized_keys file. Run the 
following commands to turn off the write permission of the files and directories: 
$ cd 
$ chmod go-w . .ssh .ssh/authorized_keys 
 

• SSH2-OpenSSH: OpenSSH servers use this format. Copy the text and save it to 
$HOME/.ssh/authorized_keys2 file. Run the following commands to turn off the write 
permission of the files and directories: 
$ cd 
$ chmod go-w . .ssh .ssh/authorized_keys2 
 

• SSH2-IETF SECSH: Some commercial SSH servers such as ssh.com's use this format. 
Copy the text and save it to a unique name such as mypublickey.pub in the 
$HOME/.ssh2 directory. And then add a line into the $HOME/.ssh2/authorization file 
such as “Key mypublickey.pub”. Run the following commands to turn off the write 
permission of the files and directories: 
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$ cd 
$ chmod go-w . .ssh2 .ssh2/authorization .ssh2/mypublickey.pub 
 

SSH Security Warning dialog box 
The SSH Security Warning dialog box appears automatically when you try to connect to the 
host when its host key is not saved in the host key database on local machine. 

 

Figure 93: Security Warning 

It shows the fingerprint of the host key and you can follow one of three actions: 

• Accept Once 

• Accept & Save 

• Cancel 

Accept Once 

Accepts the host key and connects to the host only for this time. The host key is not saved in 
the database, and you will see the same dialog box for the same connection next time. 

Accept & Save 

Saves the host key in the database and connects to the host. The SSH Security Warning dialog 
will not show up next time. You can choose this command when the fingerprint is correct and 
you connect to the host frequently. Be sure that you should remove the key from the database 
when the remote host has changed its host key. 

Cancel 

Rejects the host key and cancels the connection. 
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SSH User Authentication dialog box 
The SSH User Authentication dialog box allows you to choose an appropriate authentication 
method. It is displayed automatically when user information is required to proceed further. 

 

Figure 94: SSH User Authentication 

If a user authentication method is not allowed from the remote host, it appears dimmed. To 
use the unavailable method, you must configure the SSH server in the remote host. 

Password 

The Password authentication allows you to log on using the password of your account on the 
remote host. For security reasons, some hosts do not allow this authentication method. 

Public Key 

The Public Key authentication requires a public key to be registered on the remote SSH server. 
To log on with this method, you should select the corresponding private key in the User Key 
list. 

Keyboard Interactive 

The Keyboard Interactive (Generic Message Exchange) authentication is a relatively new 
method that prompts dynamical instructions with text box to enter appropriate messages for 
further authentication steps. 
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Fonts 
Xmanager provides many font files for X applications. A family of fonts are grouped and 
stored in a directory. A list of font directories forms a font catalogue. 

All the fonts are managed by Xmanager. The font that an X application needs to use has to be 
already installed in Xmanager. 

Even though Xmanager includes many fonts required for most systems and applications, you 
can still add new fonts. It is, therefore, important that you understand installing and managing 
fonts. 

Font format 
Xmanager supports BDF, PCF, Speedo and Type1 font formats. 

BDF (Bitmap Distribution Format) is a text-based format which can be edited with a text editor. 
Because BDF fonts are huge, they are usually converted to the PCF format to be used with 
Xmanager. The file extension is “.BDF”. To convert to PCF format, Xmanager provides the 
bdftopcf.exe program which is in the Xmanager folder. 

PCF (Portable Compiled Format) is a compiled binary format which is portable across 
heterogenous systems. It is smaller and faster than BDF fonts and the file extension is “.PCF”. 

Speedo is a scalable font format provided by Bitstreams Inc. The file extension is “.SPD”. 

Type1 is a scalable font format provided by IBM. The file extensions are “.PFA” and “.PFB”. 

Most Unix systems compress font files to save disk space, and the file extension may be 
“.pcf.Z” for PCF font files. Xmanager also can read the compressed PCF fonts. 

Font name 
The font name used in an X Window system is given according to the rules of the XLFD (X 
Logical Font Description Convention). A font name is divided into 14 parts by 14 hyphens (-). 
Between every two hyphens, there is information about the manufacturer, style, size or the 
standard organization. For example: 

-misc-fixed-medium-r-semicondensed--13-120-75-75-c-60-iso8859-1 

This kind of font name defined by the XLFD is called a well-formed font name. The font 
manufacturer does not necessarily have to use the well-formed font names when naming 
fonts. 

Well-formed font names are long and hard to remember as shown above. Therefore, an alias 
can be defined for a font to make the name simple. For more information about font alias, see 
“Font directory”. 

You can also shorten font names by using wild characters, "?" and "*" when specifying a font 
for X applications. "?" is a symbol that represents zero or one letter, and "*" represents zero or 
more letters. So, you can shorten the font name above as following to specify a font for the 
xterm program: 

# xterm –fn “-misc-fixed-*-iso8859-?” 

Of course, the names shortened like this can correspond to many font names. In that case, the 
first font on Xmanager will be selected for the application. 
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Font directory 
A font directory contains many font files, a FONTS.DIR file and an optional FONTS.ALIAS file. 

The FONTS.DIR file contains the informaiton on font files in the directory, and it should be 
updated whenever font files are added or deleted. When Xmanager starts, it reads only 
FONTS.DIR and FONTS.ALIAS files, not actual font files. Thus, even if you add a new font file, 
Xmanager cannot find it if the FONTS.DIR was not updated for the new font. You can generate 
the FONTS.DIR file using mkfntdir.exe in Xmanager folder. 

The contents of a FONTS.DIR file are simple as shown below: 

2 

6X9.PCF -misc-fixed-medium-r-normal--9-90-75-75-c-60-iso8859-1 
CURSOR.PCF cursor 

The first line shows the number of the font files in the directory. From the second line on, each 
line contains the information on each font. The file name is on the left, and the font name is on 
the right. X applications need to know only the font names, not file names. 

The FONTS.ALIAS file contains the aliases for font names. If a font name is too long to use, 
you can add an alias for the font. For example: 

fixed6x9 -misc-fixed-medium-r-normal--9-90-75-75-c-60-iso8859-1 

One alias is registered in each line. The alias is on the left and the real font name is on the 
right. After giving an alias name, you can use the alias when running X applications. For 
example: 

# xterm –fn “fixed6x9” 

This will open the 6x9.PCF font file as shown above. 

Font server 
A font server provides various formats of font files to clients through a network. It is usually 
run in the Unix or Linux systems. 

If a font server is running on the remote host, Xmanager can get required fonts from the font 
server. By using a font server, you can avoid to install fonts in Xmanager and save disk space. 

Once a font server is running on the network, you can register it in the Xconfig program to get 
font service. 

Font catalogue and font path element 
A font catalogue is a list of font path elements. A font path element is a font directory or a font 
server. It is stored in a server profile and Xmanager reads it to load font files and font servers. 

You can edit the font catalogue from The Font tab of the Properties dialog box of a server 
profile. 



 

Reference   |   161 

Error Messages 

Xmanager errors 

Could not open default font ‘fixed’. 

Make sure that the default font is specified correctly and it exists in the font folder. This error 
might happen when an invalid font directory is added or the font directory which contains the 
default font is removed from the font catalogue. 

XDMCP connection failed. Try again? 

Make sure that the remote host is ready for XDMCP connections. A dtlogin, kdm, gdm or 
xdm should be running on the remote host and it should be configured to allow remote X 
terminals. This error might happen when a firewall exists between your Windows and the 
remote host. 

Font server connection was failed. 

The font server you specified in the server profile is not ready or the hostname and port are 
not defined correctly. Make sure that the font server is working correctly on the specified host 
and port. 

Cannot establish any listening sockets – Make sure an X server isn’t already running. 

This error occurs when you specified the display number that is already used by another 
Xmanager or application. Specify a different display number or allocate it automatically. 

Xstart errors 

Another Xmanager is already running on the specified port. 

This error occurs when you specified the display number that is already used by another 
Xmanager or application. Specify a different display number or allocate it automatically. 

Unexpected option [XXX] found in command line. 

Confirm that you entered a correct command line option for Xrcmd. For more information 
about Xrcmd command line options, see “Xrcmd command line options”. 

The session file you have specified does not exist. 

This error occurs when the session you specified in Xrcmd.exe does not exist, or the shortcut 
of a session links to an already deleted session. 

Cannot find the specified X server profile. 

The X server profile specified in the Xrcmd command line option has already been deleted. You 
need to specify another server profile. 

Failed to execute Xmanager. (error = nnn) 

This error occurs when Xstart cannot execute Xmanager. There may be an error in Windows 
registry, or Xmanager program has been deleted. Try to reinstall Xmanager program. 
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Xbrowser errors 

Unknown protocol: XXX 

An invalid protocol name was entered in the Address bar. For more information about the 
protocol supported in the Address bar, see “Address bar”. 

Failed to execute XXX. (error = nnn) 

This error occurs when Xbrowser cannot execute Xshell or Xftp. Try to reinstall the Xshell or 
Xftp program. 
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Index 
3-button emulation, 133 

authentication method, 93 

auto raise window, 128 

automatic color substitution, 120 

automatic cut & paste, 49, 124 

automatic font substitution, 118 

backing store, 124 

Always, 124 

When Mapped, 124 

When Requested, 124 

bell type, 134 

broadcast list, 74 

broadcast message, 62 

color, 37 

choosing default server visual, 37 

configuring exact StoreColor, 37 

configuring RGB format, 38 

emulating 256-color, 37 

specifying RGB color database, 38 

command tags, 107 

Common dialog box 

Host Keys, 148 

SSH Security Warning, 157 

SSH User Authentication, 158 

User Key Generation Wizard, 152 

User Key Properties, 150 

User Keys, 149 

compose layout, 137, 142 

compose sequence, 142, 147 

compression, 97 

connection, 21 

connecting with Address Bar, 21 

connecting with REXEC protocol, 22 

connecting with RLOGIN protocol, 22 

connecting with RSH protocol, 23 

connecting with SSH protocol, 21 

connecting with TELNET protocol, 22 

connecting with Xbrowser, 21 

connecting with XDMCP broadcast, 21 

connecting with Xstart, 21 

running a local X application, 23 

default keyboard file, 131 

default visual, 119 

default XDMCP profile, 111 

default Xstart profile, 111 

Dialog 

Forwarding Rule, 99 

DirectColor visual, 119 

display number, 79 

display number allocation, 79 

DISPLAY variable, 93 

encryption, 97 

extension, 125 

BIG-REQUEST, 125 

MIT_SUNDRY_MULTI-BUFFERING, 125 

MIT_SUNDRY_NOSTANDARD, 125 

SHAPE, 125 

SYNC, 125 

XC-MISC, 125 

firewall, 23, 77 

keep-alive, 24 

port-forwarding, 24 

proxy address, 24 

font, 29, 159 

automatic substitution, 30 

BDF, 159 

bdftopcf.exe, 159 

convert BDF to PCF, 29 

creating font directory, 29 

creating FONTS.DIR, 29 

default text font, 118 

font catalogue, 117, 160 

font directory, 160 

font path element, 117, 160 
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font server, 160 

font tab, 116 

FONTS.ALIAS, 160 

FONTS.DIR, 160 

format, 159 

installing font packs, 29 

mkfntdir.exe, 160 

name, 159 

PCF, 159 

specifying default text font, 30 

Speedo, 159 

Type1, 159 

using font server, 30 

GrayScale visual, 119 

host key, 148 

hot key for switching keyboard, 131 

Installation and Uninstallation, 3 

keep-alive, 96 

key state, 145 

keyboard, 33 

adding keymap files, 33 

editing keymap, 34 

specifying default keymap, 33 

switching keymaps on the fly, 33 

Keyboard Editor, 136 

main window, 136 

Option bar, 140 

Toolbar, 139 

Keyboard Editor dialog box 

Edit Compose Sequence, 146 

Edit Key, 144 

Select Keyboard Type, 143 

User-defined Keysym, 143 

Keyboard Editor menu 

Edit, 138 

File, 137 

Help, 139 

View, 138 

keyboard interactive authentication, 158 

keyboard type, 143 

keycode, 141 

keysym, 141, 146 

latch, 145 

LOCAL protocol, 93 

logging session, 51 

opening log folder, 51 

reading the current log, 51 

MAC, 97 

Mode switch, 146 

monitor, 47, 135 

selecting monitor, 47 

mouse, 34 

emulating 3-button, 34 

scrolling with wheel, 34 

multiple IP addresses, 77 

multiple window mode, 54, 115, 126 

Automatic Switch, 127 

background, 127 

Local Only, 127 

Remote Only, 127 

window manager, 127 

normal layout, 137, 140 

panning, 128 

passive session, 76, 80 

passphrase, 102, 155 

password authentication, 158 

PCADDR variable, 93 

preferred SSH version, 96 

preserve system colors, 120 

print, 49 

printing an X application window, 50 

Product key, 68 

profile, 27, 78 

configuring default XDMCP profile, 27 

configuring default Xstart profile, 27 

creating, 27 

exporting, 28 

importing, 28 

sending by email, 27 

sharing, 27 

prompt, 105 

proxy address, 77 
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pseudo terminal, 98 

PseudoColor visual, 119 

public key authentication, 158 

public key format, 152, 156 

public key registration, 155 

Register Xmanager, 68 

registered commands, 94 

repeat, 145 

resource database, 125 

REXEC protocol, 93 

RGB format, 120 

RLOGIN protocol, 93 

root window size, 126 

RSH protocol, 93 

scancode, 141 

scrollbar, 126 

Secure XDMCP, 88 

security, 43, 122 

access control, 122 

changing the passphrase of a user key, 45 

creating user key pair, 44 

exporting a user key, 45 

importing a private key, 44 

registering a public key on the server, 44 

running host key manager, 44 

running user key manager, 44 

running X application securely, 43 

trusted hosts, 122 

using access control, 43 

session, 15 

allocating a display number, 18 

associating with a server profile, 18 

creating a passive session, 17 

creating an XDMCP session, 17 

creating an Xstart session, 15 

creating an Xstart session in Xbrowser, 15 

disabling local broadcast, 16 

finding a host in a different network, 16 

importing a session, 17 

sending a session by email, 17 

sharing a session, 18 

shortcut of a static session, 17 

shortcut of an Xstart session, 16 

static session, 17 

Xstart session, 15 

single window mode, 55, 115, 125 

SSH protocol, 93 

StaticColor visual, 119 

StaticGray visual, 119 

StoreColor, 120 

system tray, 128 

TELNET protocol, 93 

terminate at reset, 116 

time-out, 103 

token 

command prompt, 107 

password, 107 

user name, 106 

TrueColor visual, 119 

Tunneling 

Forwarding Rule dialog box, 99 

Listen port, 100 

user key, 149 

user key length, 153 

user key type, 153 

user-defined keysym, 143 

virtual screen, 135 

wheel mouse support, 133 

window mode, 39, 115, 125 

configuring panning, 40 

customizing root window size, 39 

selecting background, 40 

selecting multiple window mode, 39 

selecting window manager, 40 

seleting single window mode, 39 

using Auto Raise, 40 

Xbrowser, 61 

Address bar, 71 

dynamic session, 62 

main window, 61 

New Session Wizard, 79 

static session, 62 
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Toolbar, 70 

Xstart session, 62 

Xbrowser dialog box 

Columns, 86 

Options, 72 

Properties, 75 

Secure XDMCP Setup dialog box, 88 

Xbrowser menu 

File, 62 

Help, 68 

Session Context Menu, 68 

Tools, 67 

View, 64, 65 

Xconfig, 110 

main window, 110 

Toolbar, 114 

Xconfig dialog box 

Add Font Server, 129 

Add Keyboard, 132 

Keyboard Settings, 130 

Monitor Settings, 134 

Mouse Settings, 132 

Panning Settings, 128 

Properties, 114 

Sound Settings, 134 

Window Mode Settings, 125 

Xconfig menu 

Edit, 112 

File, 111 

Help, 113 

View, 112 

XDMCP Broadcast, 76 

XDMCP Indirect, 76 

XDMCP Query, 76 

XDMCP session, 80 

Xmanager, 54 

command line options, 59 

system menu, 56 

tray menu, 58 

Xrcmd command line options, 108 

Xstart, 91 

main window, 92 

Xstart dialog box 

Add Command, 104 

Advanced Options, 105 

New Session, 95, 101 

Registered Commands, 103 

SSH Protocol Setup, 95 

TELNET/RLOGIN/RSH/REXEC Protocol Setup, 
102 

Xstart session, 80 
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